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קלי

הגרסא העדכנית! הגרסא לא זאת אולי ?eMule-מ אותו הורדתם בווטסאפ? הקובץ את קיבלתם

הזה. בלינק תמיד נמצאת המדליך של העדכנית

הקדמה

?Lyx התוכנה מהי

באוניברסיטה. בלימודים מאוד כשימושית ומתגלה מסמכים לעריכת תוכנה היא ”ליך“) בעברית (נהגת Lyx התוכנה

שנכתב לדוגמה מסמך הנה מסמכים. של מהירה ויצירה מתמטיים, ביטויים של נוחה עריכה מאפשרת Lyx

.Lyx-ב

הידניות מהפעולות הרבה למכן אפשר מחשב: עם עבודה של היתרונות כל את איתה מביאה התוכנה כן, כמו

,Symbolab או Desmos ,ChatGPT כמו, אחרים לממשקים בשניה התוכן את להעתיק אפשר העתק-הדבק), (כמו

ציונים מסודרת, עבודה בנייר, משמעותי חיסכון בדרייב, יושב הכל כי אוטומטי גיבוי קבצים, של נוח ניהול ישנו

עבודה מאשר ,Lyx-ב שנכתבה עבודה לבדוק נוח יותר הרבה לבודקים כלל (בדרך הבית בתרגילים גבוהים

מאוד התרגיל בתחילת חישוב טעות וכשעושים 1 באינפי עמודים 26 של מתרגיל מתעייפת לא היד ביד), שנכתבה

הכל. ולתקן לעבור נוח

יחד מסורבלת. מרגישה Lyx עם שהעבודה כמובן מחשב, עם מתמטיקה של לכתיבה שמתרגלים לפני בהתחלה,

התוכנה. עם לכתוב ונשאר מתרגל הראשונים השבועיים את שעובר מי כל יותר או פחות בפועל זאת, עם

כשקשה בה ותשרבטו המקלדת לצד ומחברת עט עם תעבדו Lyx עם בית שיעורי עושים כשאתם - שלי עצה

נייר על משרבט כמובן אני גם ופחות. פחות בה משתמשים שאתם תראו זמן לאורך המחשב. מול לחשוב

קרובות. לעיתים

ולכן בכתב, מאשר ומסודר מהר יותר הרבה לעבוד איפשרה ממש התוכנה ספציפית שעבורי אישית בנימה אציין

בהרבה. השתפרה הלימודים חוויית כל
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http://bit.ly/3DQFe01
http://bit.ly/3sAERjE
https://he.symbolab.com/
https://www.desmos.com/calculator
https://chat.openai.com


זה? במדריך תמצאו מה

להתקין מאיך החל - התוכנה עם בעבודה שצריך מה כל תמצאו - המדליך1 - המקוצר בשמו או זה, ליך במדריך

יעילה. בצורה בתוכנה להשתמש באיך וכלה איתו), יסתדרו ביותר הטכנופוביים שגם ככה מאוד, מפורט (הסבר

מאוד. לאט - שלא ומי מאוד מהר יעבוד נכונה בצורה בתוכנה שמשתמש מי - אדגיש העבודה יעילות בהקשר

במדליך. נמצא לדעת שצריך מה כל להילחץ, צורך אין

לדלג תוכלו יותר, עוד העבודה את לייעל אפשר איך לראות רוצים ורק בתוכנה, מסויים ניסיון לכם ויש במידה

חשובים הכי החלקים התוכנה. עם נכונה עבודה על השני לחלק ישר ולדלג ההתקנה של הראשון החלק על

אלו: הם במסמך

.86 בעמוד מהמדליך, הקישורים כלל ריכוז .1

29 בעמוד קיצורים, הגדרת אחריו ומיד 28 בעמוד בסיסיים, מושגים .2

39 בעמוד מקלדת? קיצורי או מאקרואים .3

76 בעמוד המדליך, של הקיצורים קובץ .4

60 בעמוד בגמרא, המדליך .5

מגיע הקשיח העותק כי לציין למותר שלו. הרשמי הטיפו בעמוד קלי למיכאל לפנות יש המדליך של קשיח עותק 1להזמנת

בכתב קליגרפי. אומר, הווה המחבר, של היד בכתב
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העבודה סביבת והגדרת Lyx התקנת

srayaa.wixsite שריה: של באתר הרלוונטי למדריך גשו ,MAC על להתקין כדי .1 הערה

(Windows-ל) Lyx התוכנה התקנת

הבאה, בפסקה נמצאות אליה שההוראות הידנית בהתקנה התחילו .Lyx התכנה את להתקין דרכים מספר ישנן

ההתקנה את תנסו עובדת, לא וההמרה PDF-ל ליך קובץ להפוך מנסים אתם ההתקנה בסיום אם .3 בעמוד

מכן. לאחר מיד נמצאות אליה שההוראות ארזים, של האוטומטית

ידנית התקנה

ליך! את להתקין בשביל כולם את לבצע עליכם - שלבים מספר ישנם הידנית שבהתקנה לב שימו

MikTex התקנת - ראשון שלב

בעברית: ולא באנגלית הוא המחשב על שלכם המשתמש ששם לוודא יש ,MikTex שמתקינים לפני

כאן: למצוא ניתן המחשב על שלכם המשתמש שם את

המשתמש, תיקיית שם את לשנות בטוחה דרך כך כל אין בהמשך. בעיות שיצוצו סביר בעברית, והוא במידה

TexLive להתקין או ווינדווס של הבא: במדריך כמו חדש משתמש ליצור או זה כזה במצב טוב הכי ולכן

הזה. שבלינק מהמדריך MikTex במקום

הלאה. להמשיך ואפשר באנגלית משתמש שם לכם שיש נניח

הבאה: בתמונה כמו הזה, בלינק הרשמי מהאתר MikTex את הורידו תחילה
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https://srayaa.wixsite.com/math/various
https://support.microsoft.com/he-il/account-billing/%D7%9B%D7%99%D7%A6%D7%93-%D7%9C%D7%99%D7%A6%D7%95%D7%A8-%D7%97%D7%A9%D7%91%D7%95%D7%9F-microsoft-%D7%97%D7%93%D7%A9-a84675c3-3e9e-17cf-2911-3d56b15c0aaf
https://drive.google.com/open?id=1t_D94G5E75tmODNYY-BOQTFlmjuVM8bN&usp=drive_fs
https://miktex.org/download


ההתקנה. את להתחיל כדי אותו הריצו יירד, שהקובץ אחרי

שלו): האייקון על רגילה כפולה בלחיצה פשוט או ,Administrator-כ) שהורדתם ההתקנה קובץ את הריצו

התנאים: את אשרו

4



שלכם: ביוזר בחרו

עצמו: את להתקין לכם מציע הוא שבה התיקייה עם תזרמו
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:Install missing packages on-the-fly לעשות לו תאשרו

להתקין: לו תאשרו
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זריז): מאוד להיות (אמור ככה נראה פשוט אלא מסיים, כשהוא התרעה איזו מקפיץ לא שהוא לב שימו

בסדר: זה עדכונים, לבדוק לכם יציע הוא שתאשרו, אחרי
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קודם. מצא שהוא העדכונים את להתקין כדי עצמו MikTex-ל נלך עכשיו

ככה: Start Menu-ב אותו למצוא אפשר

הבאה בתמונה כמו למטה ימין בצד שלו האייקון את תחפשו אז רץ כבר שהוא שגיאה מקבלים אתם ואם

אותו: לפתוח כדי כפולה לחיצה עליו ולחצו
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כנראה (אבל Check for updates על לחצו ריקה הרשימה אם משם ,Updates ללשונית לכו שייפתח בחלון

:Update now על ואז שלבים), שני לפני Check for updates על לחצנו כי ריקה, תהיה שלא

להיסגר: לו תאשרו יסיים וכשהוא
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עצמה Lyx התקנת - שני שלב

הזה: בלינק נמצאת תמיד עדכנית הכי הגרסא עצמה. Lyx התוכנה את בלהוריד נתחיל

שהורדתם. הקובץ את הריצו

לשים רשום המשתמשים(בהוראות כלל או שלכם המשתמש עבור אותו להתקין אם בחרנו MikTex כשהתקנו

. ככה: נראה היה זה שלכם, היוזר את

אמורים אתם אז ההוראות, אחרי עקבתם אם (כאמור, MikTex עבור שבחרנו כמו האפשרות באותה נבחר כאן

(Install just for me פה: לבחור
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https://www.lyx.org/Download


אתם אם תלוי כשימושית, להתגלות עלולה שתמיד אבוריג’ינית גם ואפשר עברית הוסיפו הבאה בתמונה כאן

לא: או האקסיומטית הקבוצות תורת קורס את לוקחים

התיקייה את מצאו - לא אם שבתמונה). לניתוב דומה להיות (שאמור כלשהו ניתוב מוצא שהוא וודאו כאן

וחזרו הראשון לשלב חזרו מוצאים לא אתם ואם בעצמכם, אליה הניתוב את שם ורשמו שלכם במחשב הזאת

שנית: עליו
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אותן: להתקין לו אשרו חבילות מני כל להתקין מציע הוא בו הבא החלון קופץ אם

אוטומטית התקנה

ישר הלאה דלגו פה. שמפורטת האוטומטית ההתקנה את לבצע צורך אין - הצליחו הקודמים והשלבים בהנחה

.14 שבעמוד בעברית“ לעבודה Lyx ל-“התאמת

ואותו המחשב, על מותקן פייתון שיהיה צריכים אתם האוטומטית ההתקנה בסקריפט להשתמש כדי לב: שימו

שהוראותיה הידנית ההתקנה את בצעו פייתון, להתקין רוצים לא אתם אם מפה. ולהתקין להוריד תוכלו

האוטומטית. ההתקנה אחרי מיד נמצאות

במדמ“ח-מתמטיקה תואר שמסיימים (מהסוטים ארזים תכנית חברי כתבו האוטומטית ההתקנה של הסקריפט את

גם עובד הוא כן, כמו טוב. לעבוד אמור הוא להבנתי אבל אותו, מכיר לא ואני השירות), בתחילת בשנתיים

.(!) למאק

שלהם. באתר ההוראות אחרי עקבו המחשב על מותקן פייתון לכם כשיש

עשו אותה, לבצע כדי הבאה:“. השורה את והריצו Comman Prompt ”פתחו הבאה: ההוראה את תראו באתר

כך:

הבאה: בתמונה כמו “Command Prompt” וחפשו Start Menu-ה את פתחו
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https://www.python.org/downloads/
https://arazim-project.com/lyx-hebrew/


להעתיק, אומרים שהם הטקסט את העתיקו סייברים. של כזה שחור חלון לכם ייפתח התוכנה, את כשתפתחו

למקרה הטקסט את כאן שם לא בכוונה אני מהאתר, אותו (תיקחו להריץ כדי Enter ולחצו שם אותו הדביקו

אותו): יעדכנו והם
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בעברית לעבודה Lyx התאמת

כלליות: הגדרות

אומרת, (זאת באנגלית יהיה התוכנה של שהממשק מומלץ בעברית, קבצים עם לעבוד רוצים שאנחנו למרות

כדי כי וגם באנגלית, כתובים באינטרנט המדריכים שכל משום זאת וכדומה.). ההגדרות, שלמעלה, הכלים סרגל

באנגלית. להיות צריך הוא הממשק בתוך המקלדת באמצעות לנווט

כך: לאנגלית אותו לשנות מאוד מומלץ בעברית, יצא חלילה שלכם הממשק התוכנה של ההתקנה אחרי אם

Tools→Preferences→Language Settings→Language→User Interface Language→English :0.1 איור

במלואם. יחולו שהשינויים כדי לליך והיכנסו צאו זה, את שעשיתם אחרי

:Tools→Preferences-ל כנסו מכן, לאחר

Enter Tools → Preferences :0.2 איור

באדום: המסומנת באופציה בחרו
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Editing→Language Settings :0.3 איור

לתמונה: בהתאם הגדירו ,Keyboard\Mouse-ב וגם

Editing→Keyboard\Mouse :0.4 איור

לדעתי: נוח יותר אבל חובה לא
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Editing→Control :0.5 איור

את הקטנה הטקסט לתיבת הכניסו ,New על לחצו הבאה, בתמונה וכמו ,Editing-Shortcuts-ל לכו ולבסוף,

ולחצו הטקסט לתיבת שמתחת הריק הכפתור על לחצו זה ואחרי המרכאות) (בלי “language hebrew” הטקסט

.(Alt+Shift לא (רק לבחירתכם אחר קיצור כל או ,“F12” המקש על המקלדת עם אחת פעם

את מגבירה או המסך של הבהירות את משנה F12 על במקלדת לחיצה רבים ניידים שבמחשבים לב שימו

Ctrl-ה בין (שיושב Fn הכפתור על ללחוץ צריך האמיתי F12 את להקיש וכדי - בסגנון משהו או הווליום

ספציפית ולא שלכם, למחשב כללי באופן שנוגעת הערה זאת .F12 על איתו וביחד (WinKey-ה לבין השמאלי

לליך.
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חשובה הערה

עברית. בליך כשכותבים גם אנגלית על תמיד להיות צריכה המחשב של העברית

”עבר“: ולא “ENG” להציג צריך תמיד זה כאן אומרת, זאת

ייתכן קודם, פסקאות כמה כאמור .Alt+Shift על ולא F12 על לוחצים לאנגלית עברית בין לזגזג כשרוצים

המקלדת. של למטה שמאל בצד במקלדת הכפתור הוא Fn כאשר תשתנה, שהשפה כדי Fn+F12 ללחוץ שתצטרכו

יהיה עובדים) את שעליו התרגיל (נגיד, שלכם הליך קובץ אל שמוביל התיקיות עץ שכל חובה בנוסף, חשוב!

.PDF לקובץ Lyx-ה קובץ את כשממירים מציקה הערה להקפיץ עלול הוא לא אם שכן באנגלית,

Lyx קובץ הגדרת

קובץ לכל הגדרות ישנן מזה, חוץ תעבדו. עליו קובץ לכל תקפות שיהיו לתוכנה הגדרות הגדרנו הקודם בסעיף

נעבוד). עליהם הקבצים לכל תקפות יהיו האלו ההגדרות שגם נרצה (בפועל לאחר מאחד להשתנות שיכולות

הנכונות ההגדרות עם קיים בקובץ תשתמשו פשוט אם יהיה טוב הכי נכונות, הגדרות עם קובץ על לעבוד כדי

כרצונכם. אותו ותעתיקו

הקובץ את הורידו .19 שבעמוד לדוגמה“, “קבצים הכותרת תחת המצורפים הבאים הקבצים את נסו ראשית,

הקובץ את שמכילה התיקייה של השם אומרת, (זאת עברית מכיל שלא בניתוב אותו שמרו ברשימה, הראשון

הלאה...). וכן אותה שמכילה התיקיה של השם לגבי וכנל בעברית, אותיות מכיל לא

אבל הראשון, הקובץ את להמיר דקות מספר לו שייקחו ייתכן .PDF-ל להמיר כדי Ctrl+R לחצו מכן לאחר

בזריזות. ימיר הוא הבאים הקבצים את דאגה, אל

איך מראים הבאים והעמודים שגיאה תקפוץ PDF-ל הקובץ את להמיר שתנסו הראשונה שבפעם סביר כן, כמו

השגיאות. של הגדול הרוב את לתקן

להוריד נסו ,PDF-ל להמיר מצליח לא הוא ועדיין השגיאות לתיקון פה המוצעים הצעדים את וניסיתם במידה

.19 בעמוד לדוגמה“, “קבצים הכותרת שתחת הארחים הקבצים את

חדשות חבילות התקנת

מורדות חדשות חבילות MikTex-ב הראשון. השלב במקום MikTex שהתקין למי רלוונטי לא הזה הסעיף

צורך. לפי אוטומטית

.Packages יש זה בשביל ליך. של הראשונה ההתקנה עם הגיעו שלא תכולות שלנו במסמך לכלול נרצה לרוב

כאלו, במקרים התכנה. עם הגיעו שלא מיוחדים דברים לעשות איך לליך שמראה קטן קובץ זה Package

לקובץ מיוחדים פיצ’רים אותם את נוסיף אנחנו פעמים הרבה במחשב. מותקן להיות חייב הרלוונטי Package-ה

הזה הפיצ’ר את מכיר לא בכלל אני רגע, ”רגע, לנו יגיד הליך PDF-ל המסמך את להמיר כשננסה ואז הליך

בו“. להשתמש רוצה שאתה
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בהודעת אחר קובץ של שם עם (רק הבאה בתמונה שמאל שבצד החלון כמו שגיאה חלון יצוץ כזה במצב

הצעדים כל על מילולי (הסבר החסרות החבילות להתקנת בתמונה החצים אחרי עקבו אז כן, אם השגיאה).

התמונה): אחרי מיד מופיע

במילים:

שאמורה (Tex Live Manager רק גם להיקרא יכולה (או TLShell Tex Live Manager לתכנה היכנסו .1

שלכם. המחשב על להיות כבר

.Not Installed האפשרות את השמאלית בעמודה סמנו .2

למחשב ריסטרט לעשות נסו הבאה, השגיאה קופצת אם (א)
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למחשב. ריסטרט תעשו ואז הזה שבעמוד ההוראות אחרי עקבו אז נפתרת לא עדיין הבעיה ואם (ב)

”Latex Error:כתב הוא אם אומרת, (זאת השגיאה בהודעת שקפצה החבילה שם את חפשו החיפוש בשדה .3

החיפוש). בשורת relsize תחפשו אז File ’relsize.sty’ not found”

זהה בדיוק שלה שהשם בזאת בחרו - דומים שמות עם חבילות כמה לכם יציע הוא החלון בתחתית .4

ההתקנות רוב .install-ב ובחרו ימני מקש עליה לחצו הזאת), בדוגמה relsize) השגיאה שבהודעת לשם

שניות. חמש בערך לוקחות

אז TexLive את הראשון בשלב התקנתם וכן ,culmus.sty ספציפית הוא החסרה החבילה שם אם .5

Document-Settings-Latex-ל תלכו אלא הקודמים, בצעדים שרשום כמו culmus את להתקין תנסו אל

ותשמרו. הזאת השורה את תמחקו .\usepackage{culmus} בה שכתוב שורה שם ותחפשו Preamble

לדוגמה קבצים

Standard, minimal - ראשונה וריאציה .1

Hebrew Article - שניה וריאציה .2

Standard, fancy - שלישית וריאציה .3

המסמך בשאר עמודות ושתי בהתחלה אחת עמודה עם וריאציה .4

באנגלית וריאציה .5
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אותן לתקן ואיך אפשריות, שגיאות ,PDF לקובץ Lyx קובץ המרת

.PDF-כ אותו להגיש רוצים אתם ועכשיו יפה, Lyx קובץ וכתבתם נניח

.Ctrl+R לחצו פשוט ההמרה, את לבצע כדי

.PDF-ל ההמרה על הערות מספר

חכו קרה, לא דבר ושום Ctrl+R לחצתם אם אז ,PDF-ה את ליצור שניות כמה לו שייקחו לב שימו .1

אז לחכות וצריך הליך קובץ את יוצר כשהוא שתמיד לב שימו טוען. פשוט הוא אולי כי שניות כמה עוד

זה: את שמסמל למטה ימין בצד קטן סימן יש

לשמור. כדי Save As לו לעשות תצטרכו נפתח PDF-שה ואחרי בעצמו, החדש PDF-ה את שומר לא הוא .2

PDF-שב תראו אולי בהצלחה, מתקמפל הקודם מהסעיף דוגמה שהקובץ לראות רוצים רק את אם .3

ואין כותרות רק במסמך כשיש קורה זה ריק. הראשון העמוד את והשאירו השני לעמוד קפצו הכותרות

שתעשו. ועבודות בתרגילים ייקרה לא זה בפועל רגיל. טקסט תחתיהן

אותן: לתקן ואיך אפשריות שגיאות מספר להלן

הבאה: השגיאה קופצת אם נפוצה הכי השגיאה זאת .1
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אל שמנתבות התיקיות של השמות שכל וודאו שלכם. הקובץ אל בניתוב עברית שיש בגלל כנראה זה

או היוזר שם את לשנות נסו בעברית, הוא שלכם היוזר שם אם באנגלית. שמות הם שלכם הקובץ

היוזר: את מכיל שלא בניתוב לשמור

הסמן את שימו קורה, זה אם בתחילתו. ריק עמוד עם PDF-ל יהפוך הוא הקובץ, את שכשתייצאו ייתכן .2

של התחתונה הצלע בין רווח שיווצר כך שורה, לרדת כדי Enter ולחצו הכותרת, אחרי המסגרת בתוך

הפיתרון) את שהביא כהן ליצחק (ותודה שמעליה. לטקסט המסגרת

בלי כותרות רק כשיש רק קורה זה הראשונה, הכותרת אחרי הראשון בעמוד גדול רווח יש אם (א)

שוב. ייקרה לא זה כותרות רק ולא אמיתי תוכן גם בו שיש אמיתי מסמך וכשתכתבו תוכן,

ושל שלו ההתקנה את להסיר ממליץ אני ,MikTex עם ליך את והתקנתם כלשהי, שגיאה קופצת אם .3

שפה. להוראות בהתאם TexLive עם מחדש ולהתקין ליך,

Latex Error: File לכם: כותב והוא PDF-ל לייצא מנסים ואתם MikTex עם התכנה את התקנתם אם .4

הבאים: הצעדים אחרי תעקבו אז ,’culmus.sty’ not found

הזה. מהלינק הקובץ: את והריצו הורידו (א)

Windows של הסימן עם במקלדת, שמאל שבצד Alt-ל Ctrl-ה שבין (הכפתור Start כפתור על לחצו (ב)

עליו).

הראשונה. לאופציה והיכנסו המרכאות). (בלי “run” חפשו (ג)
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המרכאות). (בלי “texhash” הטקסט את רשמו המסך) של התחתון בחלק קטן (חלון שייפתח בחלון (ד)

שניות. כמה ייקח זה לרוץ, לו תנו - שחור חלון קופץ אם (ה)

זה .%AppData% הטקסט את והכניסו run-ה לחלון חזרו כלום, קורה שלא או שגיאה קופצת אם (ו)

הבא: הניתוב את הזה החלון בתוך חפשו נוסף. חלון לכם ייפתח

..\MiKTeX 2.9\miktex\bin\x64

אותו. ופתחו (texhash.exe-כ רשום יהיה גם (אולי texhash הקובץ את חפשו שם

הניתובים משני לאחד לכו אז , קיים) לא המבוקש הניתוב (נגיד, נכשל הקודם הסעיף גם אם (ז)

שלכם): במחשב שקיים מהם (מי הבאים

.C:\Program Files\MiKTeX 2.9\miktex\bin\x64 הזה: הניתוב או i.

.C:\Program Files (x86)\MiKTeX 2.9\miktex\bin\x64 הזה: הניתוב או ii.

ופתחו (texhash.exe-כ רשום יהיה גם (אולי texhash בקובץ בחרו הגעתם שאליה התיקייה בתוך (ח)

אותו.

.Lyx את פתחו שסיימתם, אחרי (ט)

:Tools-reconfigure-ל כנסו Lyx בתוך (י)

קצת (משפט תקוע להיות יפסיק ובסיומן דקות לשתי ייתקע הליך הכפתור, על שתלחצו אחרי (יא)

מודה). אני טאוטולוגי

זה עכשיו .(Ctrl+R לחצו - אומרת (זאת בשנית הקובץ את לקמפל ונסו הליך, את ופתחו סגרו (יב)

הגבות. את תולש אני לא ואם לעבוד אמור

יער): אור באדיבות (ההוראות הבאה השגיאה קופצת אם .5

the external program pdflatex finished with an error השגיאה: קופצת אם (א)

נסו אותו). המכילות התיקיות של (בשמות הקובץ של בניתוב עברית שיש בגלל שוב שזה ייתכן (ב)

מחדש. קמפלו ואז עברית בלי לניתוב הקובץ את להעביר

הזה). במדריך השלישי (השלב Lyx של של ההתקנה את הסירו עובד: לא זה אם (ג)

התקלה מפה. והתקינו תורידו הפעם, אבל מחדש, אותה התקינו ההתקנה, את שהסרתם אחרי
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בה השתמשתי שאני ההתקנה היא פה שצירפתי הזאת וההתקנה חדשות, בגרסאות קורית הזאת

לחכות ותצטרכו שייתכן לב שימו לקרות. אמור לא זה שבה ככה שלי, בדרייב שיושבת ב-2018

וירוסים. בזה שאין לוודא זמן קצת ייקח Google Drive-ל כי זה את להוריד שתוכלו לפני דקה

הזה: בסגנון פונטים על שגיאה קופצת אם .6

:!pdfTeX error: pdflatex (file rdavid): Font rdavid at 600 not found הזו: ההודעה או

:(Document-Settings-Fonts-ב) פה כמו הפונטים את להגדיר נסו (א)

מסומן.) יהיה לא הראשון V-שה ככה זה את להחזיר נסו אז ככה כבר זה (ואם

יער: אור באדיבות הבאים, הצעדים את נסו ,MikTex הורדתם ואם לחילופין, (ב)

אותו. וחלצו הזה מהקישור zip-ה קובץ את הורידו i.

היא המחדל ברירת .MikTex הותקן בה התיקיה לתוך שם המופיעות התיקיות 3 את העתיקו ii.

C:\Program Files\MikTex

23

https://l.facebook.com/l.php?u=https%3A%2F%2Fwww.dropbox.com%2Fs%2Fvpju5rop40te4vz%2Fculmusmiktex22-03.zip%3Fdl%3D0%26fbclid%3DIwAR0l7GY65UGXCNEpm1-NdPNihh8uCD0s7UpF8HX2DCNQNB-bBw7FD0NJikQ&h=AT3g54d3PH6QVjx-H02uE4CUUcFW9_-3B_wriDJ3Z0d05hlG-y2R6x25byWIglrAM8od1Fwwnv125KYPy-gB8wj-t8EGh--K9FNhb485L1-uWtfIgLHHMCSoLos3s7vocQ&__tn__=-UK-R&c[0]=AT3t3oZkfE-yIBpikBasnfUoUyGwwxxF9BVN1zWvZ9LF0wOnFU_Nhj_6u4iELyTk58J6aTYIb1u7WpEzW7_MBArE4LVu9m1UeiqiPoP54-kmgNxl4uR8B9ZMt7H_7I0ahj4K8SNdqyHvG2Z-xkoeaJLoClKqR9Edo4B2B_enIxSm9j5qxMfZLUym5qFwiUtUH5mVrrRFOhNG


המקש עם והריצו הבאה הפקודה את הדביקו (“Run” (שכותרתו שייפתח ובחלון ,Ctrl+R לחצו iii.

.Enter

initexmf --edit-config-file updmap

ושימרו: הבאות השורות את הדביקו שנפתח בקובץ iv.

map culmus.map

map culmusnkd.map

לגשת (אפשר בעברית) מערכת (מנהל Administrator-כ MikTex Console התכנה את פתחו v.

הבאה): בתמונה כמו ”התחל“ חלון דרך אליה

השניה: אחרי האחר הבאות, הפקודות שתי את Task לשונית דרך הריצו שייפתח בחלון vi.

דקות): מספר לו ייקח שזה לב (שימו Tools - Reconfigure על ולחצו לליך חזרו vii.
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קובץ. לקמפל נסו viii.

:File ’cp1255.def not found’ השגיאה את מקבלים אתם אם ix.

.MikTex Console ל- חזרו א׳.

.babel-hebrew את והתקינו חפשו Packages בלשונית ב׳.

דקות). מספר לו ייקח שזה לב (שימו Tools - Reconfigure על ולחצו לליך חזרו ושוב ג׳.

(Possible problems לכותרת (מתחת נפוצות. בעיות לכמה פתרונות כמה עוד יש פה .7

פיתרון. ותחפשו בגוגל הבעיה את כתבו .8

להדרכה (לקפיצה מיט“ל של בהתקנה ולהשתמש אותה להסיר תוכלו הידנית ההתקנה עם התקנתם אם .9

ולהשתמש אותה להסיר תוכלו מיט“ל של ההתקנה עם התקנתם ואם אוטומטית) התקנה ההתקנה: על

.(??) הידנית בהתקנה

לקבצים (Templates) תבניות

לדוגמה. ב-קבצים נמצאים הם שלי, Templates-ה את ספציפית למצוא בתקווה לפה הגעתם אם

הכותרת, עם חדש מקובץ להתחיל נוכל מסויים, בקורס חדש לתרגיל שניגשים פעם שבכל רוצים היינו בפועל

כזה: משהו הקודם. מהחלק ההגדרות כל ועם הזהות תעודת הקורס, מספר
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לתבנית דוגמה :0.6 איור

הבאים: הצעדים אחרי נעקוב זה, את לעשות כדי

.(Templates) התבניות כל את נשמור בו במחשב ייעודי במקום חדשה תיקייה נגדיר .1

אומרת, (זאת הבאה בתמונה כמו שיצרנו החדשה התיקייה בתור התבניות של הניתוב את Lyx עבור נגדיר .2

הקודם.): בסעיף שיצרנו התיקייה ניתוב את נבחר “4” במספר המסומן שבתמונה האדום בעיגול
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Tools→Preferences→Paths→Document templates→Browse :0.7 איור

.Lyx את מיפינו ושאליה שיצרנו בתיקייה אותו ונשמור חדש קובץ Lyx-ב ניצור .3

שיצרנו. התבניות מכלל אותו ונבחר Ctrl+Shift+N נלחץ חדש, קובץ ליצור כדי .4

27



Lyx עם נכונה עבודה

הקדמה

העכבר את לנעול צריך - Photoshop או דפדפן שאינה אחרת תוכנה בכל גם כמו ,Lyx-ב כשעובדים כל, ראשית

מישהו כשרואים לב, תשימו אם מהיר. יותר הרבה פשוט זה - הסיבה בלבד. המקלדת עם ולעבוד אחר בחדר

איך נראה הזה בחלק בעכבר. נוגע לא פשוט הוא לרוב - מאוד מהר עובד שהוא ונראה המחשב על עובד אחר

מקלדת הקשות במספר הבא המתמטי הביטוי את וכותבים שיותר, כמה המקלדת עם העבודה את מייעלים

בודדות:

∇× r =


∂
∂x
∂
∂y
∂
∂z

×

xy
z

 =


(

∂
∂y

)
· (z)−

(
∂
∂z

)
· (y)(

∂
∂z

)
· (x)−

(
∂
∂x

)
· (z)(

∂
∂x

)
· (y)−

(
∂
∂y

)
· (x)

 = 0

בסיסיים מושגים

שני בין + בקיצור רושם כשאני קיצור: רושם אני שבו הפורמט מה נגיד קיצורים, על לדבר שמתחילים לפני

השני. אחרי אחד בנפרד נלחצים הם אז מקשים שני בין רווח וכשיש ביחד, נלחצים שהם היא הכוונה מקשים

שניהם את עוזבים ואז ביחד i-ו ctrl לוחצים קודם שבו הקיצור את מסמל “ctrl+i b” הביטוי אומרת, זאת

.b המקש על ולוחצים

הקונבנציה זאת ביחד. q-ו shift-ו ctrl המקשים שלושת של לחיצה הוא זאת, לעומת ctrl+shift+q הביטוי

הזה. למסמך מחוץ גם באינטרנט שתראו הכללית

כמו המתמטיקה וסביבות ממש, הזה המשפט כמו הרגיל, הטקסט - סוגים לשני מתחלק Lyx-ב הטקסט

.ΣF = ma הבאה: המשוואה

עצמה משל בשורה העמוד, במרכז תהיה שהיא רוצים ואם ,Ctrl+m על לוחצים מתמטיקה סביבת לפתוח כדי

:Ctrl+Shift+m לוחצים

m∑
i=1

αiβi = αmBm −
m−1∑
i=1

Bi (αi+1 − αi)
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.(Ctrl+Shift+m) השני מהסוג במשוואות להרבות מומלץ וקריאות אסתטיקה מטעמי כללי, באופן

הפקודה מייצגת למשל, α האות את משלו. (Command) ”פקודה“ יש אנגלית אות סתם שאינו ביטוי לכל

.“α” בסימן “\alpha” הפקודה את תחליף Lyx המתמטיקה, סביבת בתוך ”רווח“ ואז \alpha נקיש אם .\alpha

חשוב. זה כי שהבנתם ווודאו Lyx-ב זה את נסו

נעקוף לא פעם אף - ככה זמן. מאוד הרבה לוקח שזה מקלדת, לחיצות בשבע שמדובר לב נשים אבל נחמד, זה

האמזונס. את לנו וכורתים נייר על כותבים שעוד המערות, אנשי לכיתה, חברינו את

האות לדוגמה, אצלי, סימונים. שיותר לכמה נוחים, שיותר כמה קיצורים, שיותר כמה לבנות היא שלנו המטרה

לחיצות שתי למעשה שזה ,(a ואז alt+w קודם כמובן, לימין (משמאל alt+w a הקיצור ידי על מוכנסת α

כלחיצה a ואת לוקחת, שהיא הזמן מבחינת אחת כלחיצה להחשיב אפשר alt+w (את מהיר. מאוד - אפקטיביות

הכל). בסך שתיים - נוספת

לחיצות. בשתי להכניס ניתן המשמעותיים הקיצורים רוב שאת כך במקלדת מקשים מספיק ישנם בפועל

הכותרת תחת כבר שנכתב כמו אנגלית, על להיות צריכה המחשב של השפה יעבדו, שהקיצורים כדי לב! שימו

.17 בעמוד חשובה“ ”הערה

קיצורים הגדרת

להגדיר מכן ולאחר להכניס, רוצים שאנחנו הפקודה מהי להבין ראשית נצטרך חדש קיצור להגדיר כדי ובכן,

לליך. אותה

את להקליד צריכים ואתם נניח סימנים. רצף או סימן של הכנסה שהוא - קיצור של פשוט הכי בסוג נתחיל

דאגה! אל .“∞” לסימן הפקודה את מכירים לא עוד שאתם היא הבעיה קיצור. לו להגדיר ורוצים ,∞ הסימן

באנגלית הסימן של השם את (לחפש בגוגל לחפש תמיד היא כלשהו לסימן הפקודה מה לגלות פשוטה הכי הדרך

:(“in latex” בצירוף

מתמטיקה סביבת צרו שלו, הפקודה מה לגלות כדי הסימן: של השם את למצוא אפשר עצמו הליך דרך גם

כך: שנראה כלים סרגל שמאל בצד למטה יצוץ הסביבה, את שתצרו אחרי כאמור). Ctrl+m)
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המתמטיקה סביבת של הכלים סרגל :0.8 איור

:\infty היא ושהפקודה פה נמצא ל-∞ שהביטוי יגלה זריז חיפוש

המתמטיקה סביבת של הכלים סרגל בתוך ל-∞ הפקודה מיקום :0.9 איור

הבא: במיקום שממוקם הקיצורים הגדרת לחלון נלך עצמו. הקיצור הגדרת והוא - הבא לשלב נעבור
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Tools→Preferences→Editing→Shortcuts→New :0.10 איור

הפקודה/פקודות את ואז ”math-insert” הטקסט את לנו שתצוץ התיבה לתוך נקליד פשוט קיצור להגדיר כדי

שאפשר לב (שימו “math-insert \infty” יהיה הקיצור של הטקסט הזה, במקרה כקיצור. להכניס רוצים שאנחנו

המתמטיקה). מתיבת הסמל את להעתיק פשוט

alt+w) אותם ונקיש למטה שמאל שבצד הריבוע על נלחץ במקלדת, הקיצור של המקשים רצף את להגדיר כדי

:(8

ועד n = מ-1 סדרה לסכום מרבים ואתם נניח לדוגמה, יותר. מורכבים לביטויים קיצורים להגדיר גם אפשר

פקודות. מהרבה בעצמו מורכב אשר ,
∑∞

n=1 לביטוי קיצור לעשות ורוצים לאינסוף
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הבא: הכפתור תחת (\sum נקרא שהוא (נראה
∑
ל- הסימן את יעלה זריז חיפוש

פה: נמצא תחתון וכתיב לחזקה הביטוי את

מכירים. כבר אנחנו ל-∞ הביטוי ואת

בקיצור קודם כמו ולהדביק אותו, להעתיק ,
∑∞

n=1 מתמטיקה: בסביבת הביטוי את ידנית לרשום תוכלו כעת,

:“math-insert” אחרי חדש,

חיצוני קיצורים קובץ ייבוא

”גיבוי, הכותרת תחת המסמך, בסוף שמובא בקובץ להשתמש תשקלו קיצורים, מלא להגדיר קופצים שאתם לפני

כללי באופן וגם בהמשך, פה שמופיעים הקיצורים את שמכיל ,74 בעמוד הקיצורים“ קובץ של וייצוא ייבוא

באוניברסיטה. ופיזיקה מתמטיקה ללימודי מאוד מותאם
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לפונקציות בנוגע הערה

ניתן למשל סינוס הפונקציה את דרכים. בשתי לכתוב שניתן מתמטיות פונקציות כמו ביטויים שישנם לב שימו

להשתמש שאפשר או ,(sin יוצא (וזה :n ושל i ושל s של הקשה ידי על פשוט המתמטיקה לסביבת להכניס

.(sin ככה: מודפס זה (ואז .\sin השמורה בפקודה

לה לעשות גם (וכמובן השמורה בפקודה להשתמש מעדיפים אתם - שאלה פה אין כך? אם עדיפה אפשרות איזו

זה שלוש), במקום אחת (לחיצה למחיקה והן לכתיב הן יותר מהיר זה הפונקציה. את ידנית לכתוב ולא קיצור)

הפונקציות כל את להגדיר כדאי ועוד. מיוחד בפונט זה כי יותר ברור זה תחתון, וכתיב לחזקות טוב יותר מגיב

כמו ,alt+Q-ב מתחילות הפונקציות כל למשל, המדליך של הקיצורים בקובץ התחילית. אותה תחת בקיצורים

הבאה: בתמונה לראות שניתן

הקבוצות לתורת שקשורים הסימונים כל ,alt+w-ב מתחילות המדליך של הקיצורים מקובץ האותיות כל בהתאם,

הלאה... וכן alt+o-ב מתחילים טקסט של לצביעה הקיצורים כל ,alt+i-ב מתחילים

לסוגריים בנוגע ההערה אותה בערך

סוגריים. לסביבת המוגדרת בפקודה שימוש ידי על והן מפורשת כתיבה ידי על הן להגדיר ניתן סוגריים, גם

ואז טקסט כשמסמנים העניין, לצורך - לשימוש נוחה יותר שהרבה המוכרת בפקודה להשתמש עדיף כאן, גם

- בסוגריים אותו מחליף ולא בסוגריים הטקסט את מקיף הליך אז לסוגריים, המוגדרת הפקודה את מכניסים

הסוגר את כשמוחקים כן, כמו .“(“ התו ואחריו ”)” התו ידי על כטקסט ידנית שמוכנסים לסוגריים בניגוד וזאת

ייתרון. עוד שזה כטקסט, ידנית שמוכנסים לסוגריים בניגוד נמחק, ישר השני גם אז סוגריים בסביבת הראשון

כך: נראית העדיפה הפקודה כאן,
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Ctrl+Shift+”(“ המקשים שלושת על לחיצה נגיד מאוד, מהיר קיצור עם לסוגריים הקיצורים את להגדיר מומלץ

קובץ את תכניסו אם ביותר. הזמין להיות צריך הוא ולכן הרבה, ממש בו שמשתמשים קיצור זה שכן ביחד,

עבורכם. ככה שם מוגדר כבר זה המדליך, של הקיצורים

מורכבים קיצורים

הדבקת האחרונה, המטריצה של העתקה - פעמים הרבה עצמה על שחוזרת פעולה יש לינארית באלגברה

הביטוי ושל חץ, סימן של הכנסה המטריצות, שתי שבין לנקודה הסמן העברת מימין, שלה חדש הֵעֵתק של

לחץ. מעל “R1 → R1 + 2R3”

מתמטי. ביטוי של הכנסה מסתם מורכב יותר קצת שהוא פעולות של סט זהו

command-sequence הביטוי בהמשך). (דוגמה command-sequence הפקודה עם קיצורים להגדיר ניתן זה, בשביל

בהמשך). (דוגמה אחד בקיצור פקודות של רצף להכניס לנו מאפשר

את ”הזז עבור הפקודה מהי ”העתק“? עבור הפקודה מהי - יודעים לא אנחנו הזאת בדוגמה שגם היא הבעיה

מגדירים אנחנו שבו החלון באותו ממש אותן, למצוא מאוד קל זה ובכן, הלאה. וכן השורה“? לסוף הסמן

חדשים! קיצורים

הרצויה הפקודה שם את ונמצא הקיצורים בחלון “Ctrl+C” נחפש ל-“העתק“: הפקודה השם את בלחפש נתחיל

:(Ctrl+C לוחצים אנחנו להעתיק שכדי מראש יודעים כבר אנחנו (שכן
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.“copy” הוא להעתקה הפקודה ששם מפתיע, מאוד לא באופן נראה,

אם (נגיד, המבוקשת הפעולה את לבצע היא Lyx-ב שונות לפעולות השמורות הפקודות את לגלות דרך עוד

בצד להתבונן ואז ,Lyx בתוך מאיפשהו טקסט להעתיק פשוט אז טקסט, של להעתקה הפעולה מה לדעת רוצים

עושים: שאנחנו פעולה לכל הפקודה מופיעה שם - למטה שמאל

ידי על הפקודות כל את נשרשר הסופי הקיצור את להגדיר כדי ואז האופן באותו הפקודות שאר את נחפש

; ב“נקודה-פסיק“ מופרדות הפקודות ואת “command-sequence” שנכתוב

המתקבל: הקיצור הוא זה שלנו, במקרה

command-sequence char-left-select; copy; word-right; math-insert \stackrel{\begin{cases}R\rightarrow

RR\\R\rightarrow RR\end{cases}}{\Rightarrow}; escape; paste; word-left; char-left; up; up;

char-left; char-left

הזה: הביטוי את לוקח שהקיצור 1קיבלנו 2 3

4 5 6

7 8 9



35



הבא: הביטוי את ומחזיר

1 2 3

4 5 6

7 8 9



R → RR

R → RR
⇒

1 2 3

4 5 6

7 8 9



במחשב). אצלי לחיצות (שתי כרצוננו קצר לקיצור מקלדת לחיצות עשר איזה של פעולה המרנו נהדר!

לא צריך רק שלהן, ותיקון שגיאות כתיבת של מסויים תהליך יש המורכב הקיצור כתיבת שבתהליך כמובן

לתקן ואיך הבעיה איפה להבין לנסות שציפינו, מה את מקבלים לא כשאנחנו באצבעות להזיע ולא להילחץ

בו השתמשתי אבל לבנות, דקות מעשר יותר לי לקח נגיד הזה הקיצור את וטעיה. ניסיון ידי על בעיקר אותה,

השנה. במהלך דקות מעשר יותר הרבה לי חסך והוא פעמים מאות

וקטן פשוט קיצור גם - אחת בפעם מקלדת הקשות הרבה שחוסך קיצור דווקא לאו הוא טוב שקיצור לב שימו

טוב. קיצור להיות יכול מאוד הרבה בו שמשתמשים זריז למשהו

מאוד: שימושיים קיצורים מספר להלן

. הקיצורים קובץ של וייצוא ייבוא ל-גיבוי, פנו ועוד פה המופיעים הקיצורים כל של לייבוא ׂהערה:

בריבוע ביטוי שמעלה הבא הקיצור לכן, פעמים. אלפי בריבוע ביטויים העליתי כנראה האחרונה בשנה •

הכתיבה: שטף את בהרבה שמשפר מבחינתי, מעולה קיצור הוא (3 במקום אחת (לחיצה כפתור בלחיצת

command-sequence math-superscript; math-insert 2; escape

ביטוי. של להופכי הביטוי את הקיצור אותו עם ולקבל ב-1− ה-2 את להחליף גם אפשר •

למטה שלה חדש הֶעֵתק ולהדביק הנוכחית השורה את להעתיק רוצים אנחנו הזמן וכל היות דומה, באופן •

שימושי כפתור בלחיצת זה את שעושה הבא הקיצור אלגברי), פיתוח בכל יותר או פחות שקורה (דבר

כן: גם מאוד

command-sequence line-begin; line-begin; line-begin; line-begin; line-begin; line-begin; line-begin;

line-begin; line-end-select; copy; line-end; math-display; paste;

הבאה: בדוגמה כמו שלו, המשמעות את מסויים לביטוי מעל או מתחת לסמן רוצים קרובות לעיתים •

P (A) =
365

365
· 364
365

· . . . · 365− (n− 1)

365
=

365!

(365− n)!︸ ︷︷ ︸
|A|

· 1

365n︸ ︷︷ ︸
1/|Ω|

=
|A|
|Ω|

הביטוי): את שמסמנים (אחרי לביטוי, שמתחת לסימון והמקום המסולסל הקו את מייצר הזה הביטוי •

36



command-sequence math-insert \underbrace; char-forward; char-left-select; math-insert \underset;

cell-backward; line-begin-select; cut; cell-forward; paste; cell-backward

למטה: ולא למעלה, המסולסל הקו את רוצים ואם •

command-sequence math-insert \overbrace; char-forward; char-left-select; math-insert \overset;

cell-backward; line-begin-select; cut; cell-forward; paste; cell-backward

Lyx מה משום למעלה, אחת שורה לעלות ורוצים Display Equation-ל מחוץ נמצא כשהסמן לעיתים, •

:(Ctrl+Up הוא שלה הקיצור (אצלי הבעיה את פותרת הבאה שהפקודה גיליתי אני לעלות. לו נותן לא

char-backward

של תיעוד שאחריה. לזאת אחת משורה עבר הכותב איך להבין קשה אלגברי בפיתוח קרובות לעיתים •

כפתור בלחיצת אם נחמד להיות יכול היה לכן, מאוד. נוח האלגברי הפיתוח את לעשות יכול הפעולות

במעברים כמו מבצעים, שאנחנו הפעולות את שמתעדים האפורים הביטויים את להוסיף יכולים היינו

האגפים שני על ואקספוננט השני, במעבר 1
2
ב- הכפלה הראשון, במעבר האגפים שני על (אינטגרציה הבאים

השלישי): במעבר

6x2 + 10x+ 24 = 4x2 − 4x \ − 4x2 + 4x

2x2 + 14x+ 24 = 0 \ · 1
2

x2 + 7x+ 12 = 0 \Solve

x ∈ {−3,−4}

הרלוונטית הפקודה זו אז מתמטיקה), בסביבת דווקא (לאו טקסט פשוט שמכניס קיצור להגדיר תרצו אם •

מהעברית): שרם לגלעד (ותודה

command-sequence self-insert להכניס תרצו אותו ;הטקסט

אז: בעברית במסמך אנגלית להכניס תרצו אם או •

command-sequence language english; self-insert some text;
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macros-ב שימוש

עובדים אתם אם או, פה, אותו למצוא ניתן שלי, macros-ה בקובץ מעוניינים אתם כי לפה הגעתם אם הערה:

מפה. אותו הורידו אז באנגלית מסמך על

ממש להגדיר ניתן ,(
∑∞

n=1 את שמכניס קיצור (נגיד, קימות לפקודות להגדיר יכולים שאנחנו לקיצורים בנוסף

עצמו, בפני העומד חדש כסימן
∑∞

n=1 את להגדיר ניתן הזאת, (בדוגמה macros נקראות אשר חדשות פקודות

הקיימים). הסימנים של כאוסף ולא

הבאה: בתבנית איברים של קבוצות רושמים הזמן כל שאנחנו הסתמן לינארית באלגברה דומה, באופן

c1, c2, . . . , cn

v1, v2, . . . , vk

U1 ⊕ U2 ⊕ . . .⊕ Ut

Sn = a1 + a2 + . . .+ an

עצמו על שחוזר האיבר את ביטויים, שלושה רק אכניס אני כזה מצב שבכל רוצה הייתי באידאל, ובכן,

.(n, k, t, n) הסופי האינדקס את וכן (, ,⊕,+) אותם שמפריד האיבר את ,(c, v, U, a)

הבאה: בדרך חדש macro נגדיר .macros-ה ישנם זה בשביל בדיוק

עמד שבו במקום מהצורה: ביטוי ויווצר (alt i h o) insert→math→macro-ל ניכנס .1

הסמן.

מגדירים שאתם הפקודות שכל (ממליץ הפקודה של השם את הגדירו \newmacroname כתוב שבו במקום .2

אותם) ולזכור בהם לנווט נוח אז שכן ,kali-ב מתחילים כולם אצלי נגיד תחילית, באותה יתחילו

שייכנס הקוד היא משמעותה השמאלית התיבה עקרונית הפקודה. את הגדירו הבאים המקומות בשני .3

לרוב בפועל .Lyx-ה בתוך הפקודה של התצוגה תהיה איך קובעת רק הימנית ואילו pdf-ל דבר של בסופו

הקוד. אותו את בשתיהן מגדירים

הלאה. וכן \#1, \#2, כ-#3\ הפקודה בתוך אותם להגדיר תוכלו משתנים להגדיר תרצו אם .4

כך: אצלי מוגדר c1, c2, . . . , cn של המאקרו לדוגמה, .5

באותה הוגדר), הוא שבו המסמך באותו אחר מקום (בכל בו להשתמש ניתן חדש, macro שהגדרנו מרגע .6

הליך. עם שבאו האחרים בסימונים משתמשים אנחנו שבה הדרך

אותו ממלאים ואז \root מתמטיקה בסביבת כותבים אנחנו 3
√
5 להכניס שכדי כשם ממש אומרת, זאת
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math-insert מהצורה חדש מקלדת קיצור מגדירים טוב, יותר אפילו או הזאת), בדוגמה ו-5 3) בערכים

\kaliseries של כתיבה ידי על אותו להכניס נוכל ,\kaliseries המאקרו את שהגדרנו אחרי ככה - \root

עצמו: בפני כקיצור שלו הכנסה - טוב יותר או המתאימים, בערכים אותו למלא ואז מתמטיקה בסביבת

מקלדת קיצורי או macros - הנצחית השאלה

שמכניס קיצור לו להגדיר מעדיפים אנחנו האם ,
∑∞

n=1 הביטוי את להכניס מרבים אכן אנחנו אם השאלה, עולה

בהתחלה: שהראינו הקיצור כמו האלו הסימנים את ממש

חדשה: אחת פקודה תחת הסימנים כל את תחתיו שמאגד מאקרו להגדיר שמא או

היא הסיבה חדש. מאקרו להגדיר ולא האלו לסימונים מפורש קיצור עם לכתוב לי נוח שיותר מצאתי אני

עריכה. בר הוא בכלל אם המאקרו, את מאשר הדביק, שהקיצור הגולמיות הפקודות את לערוך נוח שיותר

טועים. והם צודק אני אבל ממני, אחרת יגידו אחרים

במאקרואים? להשתמש כן ממליץ אני מתי אז

U1 ⊕ U2 ⊕ . . . ⊕ Ut הקודמת: בדוגמה כמו פעמים, מספר תבנית באיזושהי סימן לשכפל כשרוצים .1

שלוש). במקום אחת פעם ⊕ הסימן ואת U האות את להכניס לי מאפשר הזה (המאקרו

רוצה הייתי ,sin הפונקציה שישנה כמו העניין, לצורך כפקודה. שתתפקד חדשה, מילה להגדיר כשרוצים .2

הבאים macros-ה את הגדרתי אז הליך. עם מגיעות לא sin-ל שבניגוד ,Im, rank, span הפונקציות את

ייעודיים: קיצורים הגדרתי כבר ועבורם
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שלכם הקבצים כלל בתוך אחד macros קובץ כלילת

מאקרו להוסיף רוצים שאנחנו פעם בכל עורכים שאנחנו היחיד שהוא אחוד, אחד מאקרואים קובץ רוצים היינו

הקיימים. templates-ה כל את ישר ייעדכן אשר חדש,

המאקרואים קובץ את שיכלול בלבד אחת פעם ,template-וה הקבצים כל בתחילת להגדיר נוכל זה, בשביל

שלנו: העדכניים המאקרואים את הקבצים בכל לנו יהיו תמיד ככה, בתוכו.

וכן עברית שפה ,Hebrew Article-כ הקבצים, שאר כמו מוגדר להיות צריך הוא (גם חדש קובץ נגדיר .1

רוצים. שאנחנו המאקרואים כל את בו ונגדיר הלאה)

ישתנה. לא שלעולם במחשב קבוע במקום אותו נשמור .2

נגדיר ,(alt i e d) Insert→file→Child Document קובץ: כל בתחילת ונגדיר שלנו templates-ה לכל נלך .3

המאקרואים: של הרלוונטי הקובץ את ונבחר Input-ל Include Type השדה את

:templatesה קובץ בתוך macros-ה קובץ של הכללתו את שמסמל קטן אייקון נקבל .4

השני: אחרי אחד מאקרואים של אוסף - כך פשוט נראה שלי macros-ה קובץ .5
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עצמו שהתוכן כך בהתחלה, ריק עמוד עם יווצר PDF-ה macros-ה קובץ הוספת שבעקבות ייתכן הערה: .6

macros-ה קובץ של הכללתו את שמסמל שהאייקון ודאו זה את לתקן כדי השני. בעמוד רק מתחיל

שמאל בצד ובחרו לאייקון, משמאל הסמן את הניחו זאת, לעשות כדי ככותרת. ולא רגיל כטקסט מוגדר

הבאה: בתמונה כמו ,Standard האפשרות את למעלה

פה, להורדה זמין שלי, השווים בקיצורים שמשתמש מי לכל במיוחד מומלץ שהוא שלי, macros-ה קובץ .7

מפה. אותו הורידו אז באנגלית מסמך על עובדים אתם אם או,

הערה

שאם אומר זה הקובץ. של העתק ולא בלבד ניתוב הוא macros-ה קובץ את שכולל הקטן שהאייקון לב שימו

את לראות יוכל לא הוא - macros-ה קובץ את גם לו לשלוח מבלי שלכם, Lyx-ה קובץ את מישהו עם תשתפו

בתוך ישירות macros-ה כל את לכלול להיות יכולה אלטרנטיבה שלכם. במסמך שמפוזרים השונים macros-ה

מבליג אני ולכן במקביל, templates-ה כל את לעדכן פעם כל דורש וגם האמת, למען מכוער די זה אבל הקובץ,

הזה. החיסרון על

”רווח“ במקש שימוש

זאת, עם יחד רווח. במקש השימוש הוא איתם להתקשות נוטים מתחילים שמשתמשים Lyx-ב המאפיינים אחד

המתמטיקה. בסביבת מאוד שימושי מקש הוא

אין ממש המתמטיקה ובסביבת השני אחרי אחד רווחים שני לשים ניתן לא בכללי ובלאטך ,Lyx-ב כל, קודם

Ctrl+space ללחוץ תוכלו רווחים, ריבוי אחרת או כזאת מסיבה צריכים אתם זאת בכל אם רווח. כזה דבר

משלכם). קיצור לה ולתת שלה, הקיצור הוא Ctrl+Space-ש הפקודה מה לבדוק (או

.Ctrl+Enter הוא הרלוונטי הקיצור חדשה, פסקה ליצור מבלי שורה לרדת תרצו אם דומה, באופן

הסמן אם אומרת, זאת הנוכחית. מהסביבה ליציאה משמש רווח המקש זאת, לעומת המתמטיקה, סביבת בתוך

הבא: בביטוי שבחזקה ל-2 בסמוך נמצא כרגע

:sin2-ה אחרי אותו ותמקם (שבאדום), החזקה מסביבת אותו תוציא רווח על אחת לחיצה אז
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:
(
sin2 ·3

)
ל- מימין אותו ותמקם הסוגריים, מסביבת אותו תוציא נוספת ולחיצה ,

”אחריה“ אז בעברית מסמך שזה (בגלל אחריה אותו ותשים כולה מהמשוואה הסמן את תוציא נוספת לחיצה

מימינה): משמעו

משום פשוט בחצים, בשימוש ולהמעיט Tab ועם רווח עם המתמטיקה בסביבת לנווט להרבות עדיף כללי, באופן

מהיר. יותר שזה

החוצה אחת סביבה הסמן את שמוציא ,Shit+Space הוא הזה בהקשר המדליך מקיצורי שימושי קיצור כן, כמו

אגב) גאוני (קיצור אחריה. ולא לפניה אותו ושם

בצבעים שימוש

יכול בצבעים ששימוש לב שם בוודאי 3Blue1Brown האגדי היוטיוב בערוץ או Khan Academy-ב שצפה מי

ומובנים. ברורים יותר הרבה אלגבריים מעברים לעשות

מאוד קל ולכן הצבע, באותו צבועים b ושל a של חזקות אותן בעלי שאיברים לראות אפשר לדוגמה, כאן

מזה: שמח ושהבודק לשלישית, השניה מהשורה במעבר נסכמו הם איך לראות
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זה את תעשו אתם - לחיצות שתי לכם לוקחת מסויים בקטע הפונט של צביעה אם - אחר הקשר בכל כמו

תעשו לא אתם אז שניות 7 לוקח זה שניה חצי ובמקום העכבר, עם חלון איזשהו לפתוח דורש זה ואם הרבה,

תתחילו טבעי באופן מהטקסט, חלקים של צביעה עבור נוחים קיצורים לכם יהיו אם לכן, כלל. כמעט זה את

סמל זה בנוסף, יותר. לאטרקטיבי המסמך את והופך חישוב לטעויות סיכויים מקטין זה בהם. להשתמש

ובלאטך. Lyx-ב השימוש של המקצוע רזי את שלמדו לאנשים סטאטוס

alt+o-ב מתחילים הצבעים לכל הקיצורים (76 לעמוד לכו עצמם, הקיצורים (בשביל המדליך, של בקיצורים

alt+o k) הלאה וכן ירוק בשביל alt+o g כחול, בשביל alt+o b אדום, בשביל alt+o r הצבע: של האות ואז

בסביבת גם עובדים הקיצורים כן, כמו .(Bold כמו האחרים הפורמטים כל את מוריד גם והוא שחור, בשביל

רגיל. בטקסט וגם המתמטיקה

קיצורים גם ישנם המדליך של בקיצורים אז שלכם, הביטויים של מעודנת יותר קצת בצביעה תתעניינו אם

עבור חיובי אפקט אותו את עושה זה - שחור נשאר שלהם התוכן כאשר צבעוניים), (סוגריים של להוספה

האחרונה האות את כאשר alt+o alt+...-ב זמינים הקיצורים כל צעקני. פחות קצת אבל המעברים של הקריאות

הצבע. של הרגיל בקיצור כמו הצבע של השם לפי להשלים צריך

הצבעים כי החומר, את להכיר בלי גם שם, קורה מה להבין שאפשר תראו רגע, בה תתבוננו אם דוגמה. להלן

לאן: הולך ביטוי איזה להבין עוזרים מאוד

שדות. של הפעולה על מסויימת טענה .2 טענה

האינטראקציה: איבר עם בלגראנז’יאן נתבונן הוכחה.

L =
((
∂µφ†) (∂µφ))− (m2φ†φ

)
−
(
λ
(
φ†φ

)2)
:ε = ε (x) אינפיניטיסימלית הפרעה בהינתן φ של הערך את נציב

Lε =
(
∂µ (φ+ ε)† ∂µ (φ+ ε)

)
−
(
m2 (φ+ ε)† (φ+ ε)

)
−
(
λ
(
(φ+ ε)† (φ+ ε)

)2)
בנפרד: מהביטיים אחד כל )נפתח

∂µ (φ+ ε)† ∂µ (φ+ ε)
)
=
((
∂µφ†) (∂µφ) + ((∂µε†) (∂µφ) + c.c

))
+O

(
ε2
)

m2
(
(φ+ ε)† (φ+ ε)

)
= m2

(
φ†φ+

(
φ†ε+ c.c

))
+O

(
ε2
)

λ

((
(φ+ ε)† (φ+ ε)

)2)
= λ

(
φ†φ+ φ†ε+ ε†φ+ ε†ε

)
2

= λ
((
φ†φ

)2
+ φ†φφ†ε+ φ†φε†φ

)
+O

(
ε2
)

= λ
((
φ†φ

)2
+ φ†φ

(
φ†ε+ c.c

))
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ונקבל: חזרה נציב

Lε =
((
∂µφ†) (∂µφ) + ((∂µε†) (∂µφ) + c.c

))
−m2

(
φ†φ+

(
φ†ε+ c.c

))
−λ
((
φ†φ

)2
+ φ†φ

(
φ†ε+ c.c

))
+O

(
ε2
)

■ הלאה... וכן הלאה וכן

המדליך? של בקיצורים להיעזר בלי בעצמנו הקיצור את להגדיר נוכל איך

טקסט על גם בה להשתמש אפשר (שכן ביותר האוניברסלית הדרך זאת אבל טקסט לצבוע דרכים כמה ישנן

האחרות): הצביעה לפקודות בניגוד מערכים, על וכן המתמטיקה לסביבת מחוץ

:(alt e s c) Edit→Text Style→Customized→Color-ב הרלוונטי הצבע של המיקום את חפשו ראשית

הלאה: וכן ,3 במקום הוא “blue” ,2 במקום הוא “black” ,1 במקום הוא “no color” כאשר
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הזה (במקרה קודם שמצאתם האינדקס ישנו באמצע המודגש במספר כאשר הבאה, לפקודה קיצור הגדירו

:(No Color אחרי ברשימה השלישי במקום הוא הכחול הצבע שכן בכחול, הטקסט את צובע הביטוי

textstyle-update color 3 language ignore

ידי על אותם לערוך תוכלו ,Lyx-ב מחדל כברירת שמוגדרים והצעקניים הזרחתיים הצבעים לכם מפריעים אם

האחרונה (השורה הבאה בצורה כרצונכם מחדש והגדרתם Document→Settings→LaTex Preamble-ל כניסה

רלוונטית): לא

ובטקסט:

\usepackage{xcolor}
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\definecolor{blue}{RGB}{0, 0, 140}

האלו השורות מסמך להגדרת בהוראות והן דוגמה כקבצי המדריך בתחילת שצירפתי בקבצים שהן לב שימו

הצבעים. רוב עבור מצורפות כבר

למסמך. ייעודיות קונפיגורציות מני כל להוסיף שלכם המקום הוא LaTex Preamble-ה כללי, באופן

Theorems-ב שימוש

הבא: התפריט ישנו למעלה שמאל שבצד לב שימו

Proof-ב נבחר אם לדוגמה, וכדומה. הוכחות/טענות/משפטים שונים, בגדלים כותרות לעשות מאפשר זה תפריט

הבא: בעיצוב מתמטי קטע לכתוב נוכל Claim-וב

מגבון. לא זה מגבון ועוד מגבון המגבונים). (משפט 3 משפט

מגבונים. שני זה מגבון ועוד מגבון הוכחה.

המשפט, על ימני מקש (או Alt+a 1 לחצו הזאת), בדוגמה המגבונים“ (“משפט המשפט של השם את להוסיף כדי

לרפרנס ויאפשר לרפרנסים, כשנגיע יותר מאוחר במיוחד שימושי זה .(Add Theorem Text באופציה בחרו ואז

■ המשפט. שם את להכיל

כל התחילו מציע. שהליך Layout-ל השונות באפשרויות בשימוש שיותר כמה להרבות היא טובה דירקטיבה

סעיף וכל משלה Section-ב בתרגיל שאלה כל התחילו משלה. Proof-ב הוכחה וכל משלו Theorem-ב משפט

הליך שכן בקלות במסמך לנווט לכם מאפשר וגם לקריאה נוח יותר הרבה זה הלאה. וכן משלו, Subsection-ב

לעריכה ונוח קריא מאוד הקובץ העליון. הכלים שבסרגל Navigate ללשונית אותם ומכניס כותרות שאלו מבין

כך: נראה כשהוא
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תראו Adobe Acrobat Reader-ב הזה המדריך את תפתחו אם למשל, עניינים. תוכן להגדיר מאפשר זה בנוסף,

בקלות: לנווט שמאפשר אינטראקטיבי עניינים תוכן למעלה שמאל בצד

תהיה שהיא ככל וכן קרובות, לעיתים עצמה על שחוזרת פעולה זו (שכן קיצורים להגדיר נרצה פה שגם כמובן

ככה שלמעלה. Dropdown-ב העכבר עם פעם בכל זה את להגדיר ולא בה) להשתמש נרבה ככה נגישה יותר

:layout לפקודת קיצור של הגדרה נראית
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הוכחה של אלגנטית לכתיבה טיפ

הבאה: בתצורה להשתמש ממליץ אני קריאה שתהיה וכדי כותבים, שאתם הוכחה בתוך לאיבוד ללכת לא כדי

קצרים. משפטים להרבה אותה ומפרקים ,(alt+p b) בבולטים כותבים ההוכחה את

דוגמה: להלן בהוכחה. כותבים שעכשיו הנקודה של העומק לפי קובעים שלהם (indent) ההזחה את

ראשוני. ומסדר סופית היא ⇐⇒ פשוטה היא אבלית חבורה .4 טענה

הוכחה.

אבלית. חבורה P תהא

:⇒ •

ראשוני. ומסדר סופית P כי נניח –

.|P | = p את מחלקת P של חבורה תת כל לגראנז’ ממשפט *
הטריוויאלית. ולחבורה לעצמה פרט חבורות תת לה אין לכן *

פשוטה. והיא נורמליות חבורות תתי לה אין בפרט, *

:⇐ •

:p מסדר סופית אינה שהיא בשלילה ונניח פשוטה P כי נניח –

:p מסדר ואינה סופית P אם *
ראשוניים: למספרים שלה הסדר את לפרק ניתן אז ·

|P | = pr11 · pr22 · . . . · prnn

.pr11 בגודל ממש חבורה תת לה יש הראשון סילו ממשפט ·
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נורמלית. היא P של חבורה תת כל מאבליות, ·

.P של לפשטות בסתירה נורמלית חבורה תת של קיום קיבלנו ·

סופית: אינה P אם *
פשוטה. אינה שהיא Z-ל איזומורפית שהיא בספר ראינו אז ציקלית P אם ·

היא שאם (משום e ≤ ⟨g⟩ ≤ P ש- כך e ̸= g ∈ P איבר ישנו אז ציקלית אינה P אם ·

.(e ̸= g ∈ P לכל נכון זה ציקלית אינה

פשוטה. היותה את סותר הדבר מאבליות ושוב, ·

■

עכשיו יושבת היא בדיוק איפה שלה ההזחה לפי שורה כל על לראות כשאפשר נוח מאוד זה רואים, שאתם כמו

בהוכחה.

שרם: גלעד באדיבות - משודרגים Theorems-ב שימוש

,Theorems-ה של וכדומה) מסגרת פונט, (צבע, הפורמט את שעורכים קבצים כתב העברית מהאוניברסיטה גלעד

(כמו הערוכות בסביבות שמשתמש מסמך נראה ככה ו-“הבחנה“. ”השערה“, כמו נוספות, סביבות מוסיפים וכן

לבן): בשחור שכולו למסמך בהשוואה וקריא מזמין יותר הרבה זה רואים, שאתם

הזה. המדריך אחרי עקבו המשודרגות בסביבות להשתמש כדי
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Overleaf לבין ליך בין ההבדל על

הזה הזאת בפסקה .Overleaf ושמו - מדעיים מסמכים של לכתיבה אחר בממשק נתקלתם או ששמעתם סביר

לכם. שמתאים מה את לבחור שתוכלו כדי מהממשקים אחד בכל היתרון מה להסביר אנסה

עובדים כשאנחנו מסמכים. ליצירת קוד שפת היא LATEX - בפשטות .LATEX זה מה להבין צריך כל, ראשית

הסופי. PDF-ל דומה יותר ליך של והממשק הקלעים, מאחורי שנכתב LATEX-ה קוד את רואים לא אנחנו בליך

תכנה. של קוד לכתוב כמו קצת נראה שזה שאומר מה גולמי, LATEX-ב כותבים זאת, לעומת ,Overleaf-ב

(זה קוד כמו שנראה השמאלי בחלק כותבים כאשר ,Overleaf של הממשק את לראות אפשר הזאת בתמונה

:PDF-ה את לראות אפשר הימני ובחלק (LATEX קוד

עדיף? מה אז,

משתמשים: אנחנו שבו לממשק שימושים שני ישנם

בעל פיזיקה או מתמטיקה לעשות אפשר אי כי עליו לכתוב משהו צריכים שאנחנו הוא הראשון הצורך .1

בו. ולהתנסח לשרבט מחשב או אייפד או ונייר עט לפחות חייבים - בראש פה

אם בין הגשה, בר לקובץ שלנו הבית שיעורי את שיהפוך משהו כלי צריכים שאנחנו הוא השני הצורך .2

PDF-ל ייצוא או האייפד של PDF-ל ייצוא או הפלאפון, עם מהמחברת הבית שיעורי של סריקה זה

.Overleaf/מליך

בהרבה: נוחה שליך חושב אני - הראשונה לנקודה שקשור מה בכל

של מכתיבה יותר (הרבה מאוד מהר לעבוד לנו שמאפשרים המקלדת קיצורי ישנם כי ובראשונה בראש •

בכלל תנסו אתם אם ההבדל את שיעשה מה יהיה דקות, לעשר דקה בין ההבדל לפעמים (.Overleaf קוד

לא. או הבעיה את לכם יפתור המטריצה של דירוג אם לראות

שמייצג קוד ולא עצמם, המתמטיים הסימנים את עורכים אנחנו אז משוואה עורכים כשאנחנו לכך, מעבר •

של החזקה את לשנות רוצים שאתם החלטתם למעלה שפה בתמונה נגיד, אם .Overleaf-ב כמו אותם

הזה הסרבול שמשמאל. Editor-ב הרלוונטי הקוד את למצוא צריך אז ל-3, מ-2 השלישית בשורה פאי

ככה. לחשוב קשה יותר ובעיקר יותר לאיטי הכל את הופך
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הזה? המתמטי הקטע את - לערוך נוח יותר יהיה מה לדוגמה,

שלו? הלאטך קוד את שמייצג הבא הטקסט על או

1. \psi_{L,{\color{blue}a}}\left(x\right)\rightarrow\psi_{L,{\color{blue}a}}^{\prime}\left(x\right)={\color{gray}\overset{\text{Matrix-

vector multiplication}}{\overbrace{{\normalcolor {\color{gray}\underset{M_{2\times2}\text{ over

}\kaliComplex}{\underbrace{{\normalcolor \left[e^{i\left(a_{{\color{green}\alpha}}-ib_{{\color{green}\alpha}}\right)\frac{{\color{gray}\overset{M_{2\times2}\text{

over }\kaliComplex}{\overbrace{{\normalcolor \sigma_{{\color{green}\alpha}}}}}}}{2}}\right]_{ab}}}}}{\color{gray}\underset{\in\kaliComplex^{2}}{\underbrace{{\normalcolor

\psi_{L,{\color{blue}b}}\left(x\right)}}}}}}}}

כותבים שאתם כדי תוך אמת בזמן ולא שניות, כמה אחרי רק מתעדכן שמימין PDF-ה קובץ כן, כמו •

הקוד. את

.Overleaf על עדיפה ליך האלו במובנים

משלה: יתרונות יש Overleaf-ל מנגד,

התקנה. דורש ולא וובי ממשק זהו •

הכי הפיתרון (בליך שונים במחשבים אחד קובץ על משותפת לעבודה יותר נוח הוא - וובי והוא היות •

המחשב). על המשתתפים לכל שיושבת שיתופית תיקייה הוא לדעתי יעיל

הקובץ. של התכונות כל על מקסימלית שליטה ישנה גולמי, LATEX עורכים Overleaf-וב היות לכאורה, •

באמת לא תכלס, לפתור. קל יותר להיות יכול Overleaf-שב קצה מקרי מני כל להיות עלולים - לכאורה

רלוונטית. הזאת הנקודה כמה בטוח לא אני אז כאלו, במקרים נתקלתי

לכתוב לבין לליך) מקביל (שזה בפייתון/מטלאב לכתוב בין ההבדל כמו קצת הוא הממשקים שני בין ההבדל

אוסיף יותר. מלאה שליטה מספק והשני נוח, יותר הראשון - (Overleaf-ל מקביל (שזה מכונה בשפת או C-ב

לאורך שמגישים תרגילים 400 כל מזה ויותר בליך, לפתור אפשר שאי עיצובי בדבר נתקלתי לא שעוד ואגיד

לדעתי. בעיה לא שזו ככה הפורמט, באותו להגיע יכולים הראשון התואר

שלי? הדין פסק מה אז

של לכתיבה מתאים יותר הרבה שהוא ליך, עם תעשו הראשון תואר של הרגילים התרגילים כל את מסקנה.

לעשות תנסו שיתופית, עבודה שדורש אחר פרויקט כל או מעבדה, דו“ח לכם יש אם בית. שיעורי של מסות

להגיש סתם מתישהו תנסו ייצא, לא זה גם אם שיתופית. לעבודה מתאים יותר הוא כי Overleaf-ב אותו

להכיר. כדי Overleaf-ב תרגיל איזשהו
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שונות פעולות

וכו’ לטענות למשוואות, במסמך, אחרים לחלקים ולינקים התייחסויות

משתנים, ודברים והסדר שכשהמספור כך במסמך, אחר חלק כל או טענה או למשוואה התייחסות להכניס ניתן

הבאה: בתמונה כמו אוטומטית, בצורה תשתנה ההתייחסות

זה: את נעשה ככה

היכנסו וכדומה), טענה/משפט/הגדרה כותרת, (משוואה, להתייחס תרצו אליו במקום הסמן את מקמו .1

קטנה תווית תקבלו .Label-ל שם ותנו ,(alt+r l שלי הקיצורים עם או ,Alt i l (קיצור: Insert→Label-ל

במשוואה): והשניה בטענה האחרת בתמונה, שתיים (יש כך שנראית

בחרו .Insert→Cross Reference-ל והיכנסו שסימנתם לאובייקט להתייחס רוצים אתם בו למקום לכו .2

ואשרו: הרלוונטית התווית את
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הרפרנס את ימיר גם וזה alt+r r עם הרפרנס את להכניס תוכלו אז שלי, בקיצורים משתמשים אתם אם

alt+o עם שחור לטקסט חזרו בקיצור שהשתמשתם אחרים רפרנס. שזה ברור שיהיה כדי כחול, לטקסט

.k

בחלון לבחור תוכלו אז ,(alt+a 1 (עם לתצוגה שם התייחסות שמים אתם אליה לסביבה נתתם אם (א)

עם יודפס הלינק ואז Reference format→Textual Reference באופציה Cross Reference-ה של

המגבונים. משפט פה: כמו לסביבה, שנתתם השם

שתתנו השם .PDF-ב ולא בליך רק יוצג (alr+r l (עם Label-ב לסביבה שתתנו השם - לב שימו

.PDF-ב גם יוצג (alt+a 1 (עם הנוסף בטקסט

אתם שאליה משוואה לאותה ייקפוץ PDF-ה עליה שבלחיצה ככה לינק, ממש תהיה שההתייחסות תרצו אם

עובדים אתם עליו המסמך אם רק (רלוונטי Document→Settings-ב הבאה האופציה את לסמן תוכלו מתייחסים

שגיאות): זורק זה Hebrew Article-ב ,AMS Article הוא
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לכן: קודם הזאת בתמונה שראינו כמו PDF-ה למסמך העניינים תוכן לייצר כדי בנוסף,

.Generate bookmarks את לסמן החלון באותו נוכל

.Help->UserGuide->Section 6.1 את בליך פתחו לינקים על ליך של המקורי להסבר

למסמך תמונות הכנסת

ברשימה 1-5 (שלבים מוצלחת בצורה למסמך תמונה להכניס כדי לעשות שצריך טכניות פעולות כמה ישנן

לתמונה): מתחת קצר) (הסבר Caption-ו מספור להוסיף ומאפשרים רשות הם הבאה

.(alt, i, a, down, enter) Insert→Float→Figure-ל היכנסו .1

:settings-ב ובחרו ”float: ”איור הכפתור על ימני מקש לחצו שנוצר, בריבוע .2
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“Here Definitely” ב-: בחרו שקפץ, החלון בתוך .3

שהטקסט כך Two-Column-Document אפשרות את סימנתם Document-Settings-Text Layout-ב אם .4

העמודות, שתי פני על תתפרס שהתמונה רוצים ואתם שונות, עמודות לשתי מחולק עמוד בכל במסמך

.Span columns הצ’קבוקס את גם האחרון בחלון לסמן תוכלו

פה: ממש - אומרת זאת התיבה, שבתוך לתיבה מימין המקש את שימו .5
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אפשרויות: שתי יש לכך עצמה. התמונה את לצרף רוצים אנחנו עכשיו .6

במקום הסמן את לשים פשוט תוכלו אז - Print Screen שעשיתם או התמונה, את העתקתם אם (א)

בשם, התמונה את לשמור לכם יציע הוא .Ctrl+v עם ולהדביק תשב שהתמונה רוצים אתם שבו

הליך) קובץ עם התיקייה באותה התמונה את לשמור זה נוח הכי (לרוב מתאים מקום ותבחרו

ותאשרו.

Browse תחת ובחרו (alt, i, g) Insert→Graphics-ב בחרו במחשב, כקובץ שמורה כבר התמונה אם (ב)

לעשות אפשר - שלי בקיצורים (למשתמשים (!PDF קובץ לבחור גם (אפשר מהמחשב. הקובץ את

רשות כאמור שהם פה הראשונים הצעדים חמשת את גם רוצים אם alt+r f-ב או alt+r g-ב זה את

בלבד.)

לניתוב: בנוגע הערות שתי i.

באנגלית. רק - בעברית תיקיות להכיל יכול לא התמונה של שהניתוב לב שימו א׳.

כמו במחשב ערכית חד-חד בצורה הקובץ את שמתאר מלא הניתוב בשורת להכניס אפשר ב׳.

לדוגמה:

C:\Users\GiladTal\Drive\Exercise 1\Images\my_big_muscles.png

זאת הליך. קובץ יושב שבו למיקום ביחד שנמדד יחסי ניתוב להכניס אפשר לחילופין,

והתמונה לדוגמה, מהניתוב Exercise 1 התיקייה בתוך נמצא הליך קובץ שאם אומרת

בתוך להכניס תוכלו אז ,Exercise 1 בתוך נמצאת שבעצמה Images תיקייה בתוך נמצאת

.Images\my_big_muscles.png את רק לתמונה ניתוב

מחשבים מכמה שיתופית בתיקייה שיושב קובץ על עובדים ואתם נניח שימושי? זה למה

בתיקייה שיושב מעבדה דו“ח על למעבדה חברים עם ביחד עובדים שאתם או שונים,

ממחשב משתנה (C:\Users...-ב שמתחיל (זה שלו האבסולוטי הניתוב אז - שיתופית

הניתובים פתאום אז לאחר אחד ממחשב כשעוברים שבה הבעיה את יגרור זה למחשב.

הוא (כי PDF-ב ולא בליך לא - התמונות את לראות אפשר ואי תקפים, לא נהיים

רק מוגדר יהיה זאת, לעומת היחסי הניתוב החדש). במחשב קיים שלא לקובץ מתייחס

שונים. מחשבים בין עבודה מאפשר ולכן השיתופית, התיקייה לפי

אותה. להקטין תצטרכו כזה ובמצב המסמך בשביל גדולה מדי יותר הרבה תהיה התמונה לרוב ii.

השלבים שני את בצעו ואז שלה ההגדרות את לפתוח כדי הליך בתוך עצמה התמונה על לחצו

הבאים:

של הגודל את משנה לא (זה הבא השדה את הגדירו הסופי pdf-ב אותה להקטין כדי א׳.

את מגדיר נגיד אני הזאת בדוגמה הסופי. pdf-ב שלה הגודל את רק ,Lyx-ב התמונה

הזה): בעמוד הטקסט של מהרוחב 40% להיות חחח...) הזאת הדוגמה (של התמונה
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איך את משנה לא (זה עצמו: Lyx-ב התמונה את הקטינו ההזדמנות באותה כבר וגם ב׳.

(Lyx-ב שלכם הנוחות בשביל רק זה הסופי, pdf-ב יראה שזה

קבוע לרוחב כולן את להקטין רוצים ואתם תמונות, הרבה עם גדול מסמך כתבתם אם ג׳.

הגודל של מחדש ב-הגדרה שמתואר kalikton הסקריפט על ממליץ אני כפתור, בלחיצת

kalikton.py - במסמך התמונות כל של

alt+a הקיצור על ולחצו התמונה ליד הסמן את שימו המסמך באמצע התמונה את למרכז כדי iii.

ובחירה (alt e p) Edit→Paragraph Settings-ב ידנית זה את לעשות אפשר לחילופין, .c

alt+r עם התמונה את והכנסתם שלי בקיצורים משתמשים אתם אם .alignment - center-ב

- המדליך של הקיצורים עם זה ככה בשבילכם. כבר זה את יעשה הקיצור אז alt+r f או g

לפנק. לפנק לפנק, רק
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על קטן (הסבר Caption-ה את כתבו הראשונים הצעדים חמשת את עשיתם אם לבסוף, iv.

שלכם. במסמך ויפה אלגנטית תמונה ותקבלו ל-“איור“ מימין התמונה)

לדוגמה: v.

את לשנות ובכך להסתובב יכול אשר שתחתיהם השחור המעמד וכן בדרכו, שעומדים החוטים זוג מאחורה, הלייזר :0.11 איור
הלייזר של האופטי לציר החוטים מישור שבין הזווית

לאחת בעברית שם יש כי כנראה זה אז שלה הניתוב רק מופיע התמונה ובמקום PDF-ל הקובץ את המרתם אם

לניתוב התמונה את להעביר או לאנגלית, התיקייה שם את לשנות ותצטרכו נמצאת, התמונה שבה התיקיות

בליך. ולעדכן אחר

עברית: בו יש כי לדוגמה תקין לא ניתוב זה

C:\Users\היטלר\University\Third semester\Analitical mechanics\Exercise 1\Invasion_to_poland_plan.png

לשרטוטים: בנוגע הערה

ידי על לכם שמסופקים Google Drive/Dropbox/OneDrive-ב ישבו הבית שיעורי קבצי כל באידאל, .1

לתיקייה בזריזות ולהיעלות להיסרק יכול במחברת שתשרטטו שרטוט כל אז המצב, זה אם האוניברסיטה.

הליך לקובץ מצורף להיות בליך כפתור לחיצות בשתי ואז הענן, שירות של האפליקציה עם המתאימה

כתמונה.

לצרף ואז Desmos-ב אותן לשרטט זה טוב הכי עבורן, אנליטי ביטוי לנו שיש לפונקציות שקשור מה בכל .2
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הלינק. את ולצרף בדסמוס לשמור או סקרין פרינט

זה נוח שהכי הרושם את קיבלתי אני אז ,Lenovo Yoga כמו עט עם Windows מחשב לכם יש אם .3

ככה לתמונה. לייצא ואז זום) פגישת לפתוח בלי אותו לפתוח (אפשר זום של Whiteboard-ה עם לשרטט

נראה: זה

חיצוניים לאתרים לינקים

זה ובשביל ממוצעות, בדיחות עם התרגיל בפיתרון שלנו המתמטית היכולת חוסר על לחפות יש קרובות לעיתים

לדוגמה. לינק שימושיים: מאוד להיות יכולים לאנטרנט לינקים

פשוט זה אז המדריך) שבתחילת לדוגמה הראשון הקובץ Standard article מסוג במסמך עובדים אתם אם

שיופיע. לחלון הלינק את והכניסו (Alt i k) Insert→Hyperlink-ל היכנסו מאוד:

של הטקסט את ממיר וגם לינק מכניס גם alt+r k הקיצור אז שלי הקיצורים בקובץ משתמשים אתם אם

הקיצור עם הלינק את שתכניסו אחרי לינק. שזה PDF-ב ברור שיהיה כדי תחתון, קו עם כחול לטקסט הלינק

.alt+o k לחצו רגיל שחור לפונק לחזור וכדי תחתון קו עם כחול יהיה עדיין הפונט

הדרך מסובך. יותר מעט זה אז המדריך) בתחילת שצורף השני (המסמך Hebrew Article עם עובדים אתם אם

היא: שלי במחשב שעובדת שגיליתי

משלו: בשורה הבא הטקסט את Document→Settings→LaTex Preamble-ב הוסיפו .1

\usepackage{hyperref}

F12 על לחיצה ידי על לאנגלית עברו .2

הקיצור) את דרסתם לא אם Ctrl+L (בקיצור Insert→Tex Code-ל היכנסו .3

הקוד: את הכניסו .4

\href{www.google.com}{This text will be displayed}

בעברית אותיות מכיל שלכם הלינק אם לכן, בעברית. טקסט להכיל יודעת לא הזאת שהתיבה לב שימו

הזה. באתר עברית מכילה שלא נרדפת לצורה אותו להמיר תוכלו
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בגמרא המדליך

להכיר: חשוב

שלנו PDF-ה לתוך אחר PDF הכנסת

כותבים. שאנחנו pdf-ה בתוך אותו ולכלול pdf לקחת רוצים לפעמים

כך: לעשות צריך כזה, במצב

לאנגלית. לעבור כדי F12 לחצו .1

(alt i e m) Insert→file→External Material-ב בחרו .2

למטה PDF Pages האפשרות ואת browse בכפתור הקובץ את בחרו .3
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הרלוונטיים: העמודים את בחרו .4

ותאשרו. .5

קוד סביבת

הבא: הקוד כמו שלנו, למסמך קוד להכניס נרצה לעיתים

1 c l a s s WaveFunct ion :

2 de f _ _ i n i t _ _ ( s e l f ,

3 p s i : np . nda r r ay , # The i n p u t wave f u n c t i o n i n one z=con s t p l a n e
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4 c o o r d i n a t e s : Coord ina t eSys t em , # The c o o r d i n a t e sys tem of t h e

i n p u t wave

5 E0 : f l o a t , # Energy of t h e p a r t i c l e

6 ) :

הבאים: הצעדים עחרי עקבו זה בשביל

(enter עם (פשוט שורה רדו .1

(alt+shift לא המדליך, של הקיצורים עם F12) לאנגלית עברו .2

מהקיצורים alt+r p הקיצור עם או ,insert -> program listing דרך Program Listing סביבת את הכניסו .3

המדליך: של

בפנים, כשהסמן המדליך של בקיצורים alt+r i) שלו ההגדרות את לפתוח תצטרכו טוב, ייראה שהקוד כדי .4

:(settings-ו ימני מקש או

המתאימה: בשפה תבחרו כל קודם להגדרות, שנכנסתם אחרי .5
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הקוד. לעיצוב ספציפיות הגדרות להדביק תוכלו שם ,Advanced-ל לכו אז יפה, ממש שיראה תרצו אם .6

מראש. מוכנות תבניות מפה לקחת תוכלו

הקוד, סביבות לכל מחדל כברירת משותפות יהיו הקוד נראות של הספציפיות ההגדרות שאותן תרצו אם .7

Document-Settings-Latex-ב ההגדרות את תגדירו אז הסביבות, לכל בנפרד אותן להגדיר תצטרכו ושלא

הליך: מסמך בתוך Tex בסביבת או אחריהן, הבאה lstset הפקודה את תוסיפו ואז Preamble

\definecolor{codegreen}{rgb}{0,0.6,0}

\definecolor{codegray}{rgb}{0.5,0.5,0.5}

\definecolor{codepurple}{rgb}{0.58,0,0.82}

\definecolor{backcolour}{rgb}{0.97,0.98,0.99}

\definecolor{codeblue}{rgb}{0,0,0.3}

\lstdefinestyle{mystyle}{

backgroundcolor=\color{backcolour},

commentstyle=\color{codegreen},

keywordstyle=\color{codeblue},

numberstyle=\tiny\color{codegray},

stringstyle=\color{codepurple},

basicstyle=\ttfamily\footnotesize,

breakatwhitespace=false,

breaklines=true,

captionpos=b,

keepspaces=true,

numbersep=5pt,

showspaces=false,

showstringspaces=false,

showtabs=false,

tabsize=2

}

\lstset{style=mystyle}

הבאה: השגיאה את מקבלים אתם אם .5 הערה
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בתחילתו: והוסיפו Document-Settings-Latex Preamble-ל לכו את

\usepackage{listings}

נשמר שלא Lyx קובץ שחזור

בלי נסגרה התוכנה אם גם אחת, פעם נשמר שהוא מרגע שלו. היצירה עם מיד קובץ כל תשמרו כל, ראשית

גיבוי. בקובץ אותו תגבה תמיד היא לשמור,

כך: אליו לגשת ניתן יהיה הנראה ככל אחת, פעם אפילו אותו לשמור מבלי גדול קובץ ועשיתם נניח

:Tools-Preferences-Paths-Temporary Directory-ל גשו
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על עבדתם שבו המשוער התאריך את חפשו הבאה. בתמונה כמו lyx החיפוש בשורת וחפשו לתיקייה כנסו

אותו: ופתחו הקובץ

המבוקש. הקובץ להיות אמור זה זהו,

הקובץ את שומרים אם כי זה, את לעשות צריך הייתי וטרם שנים שלוש התכנה עם עובד כבר אני שוב, אבל

פעם. אף לאיבוד הולך לא מידע אף אז אותו כשיוצרים מיד

מתמטיקה סביבות בתוך All Replace

יופי. עובד הוא באנגלית 2.3 ובליך 2.4 בליך אבל ,2.3 בליך בעברית במסמכים בעיות עושה הזה הפיצ’ר

שבכולן משוואות 15 עם עצמכם את ומצאתם הפיתוח בתחילת מטופשת אלגברית טעות לכם והייתה נניח

הדף את למלא יצטרכו שלהם והניירות העטים כל עם עמיתינו .(1− τ 2) במקום (1 + τ 2) שמאל באגף כתוב

בסטרימינג גָ’אז ושומעים סודה שותים אנחנו קלאס, יש לנו לא, אנחנו אבל - לתקן כדי טיפקס או בקשקושים

Edit החלון את נפתח (1 + τ ב-(2 (1− τ 2) של המופעים כל את להחליף כדי בסיאטל. מקומית רדיו מתחנת

המסך: בצד הזה החלון את ונקבל מקלדת) בקיצור Ctrl+Shift+F) -> Find and replace (advanced)
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הביטוי את ונדביק עצמו) הליך בתוך כמו ,Ctrl+m (עם מתמטיקה סביבת נפתח שייפתח שבחלון העליון בשדה

(כאמור, יוחלפו. והביטויים Replace all להחליף. נרצה אליו הביטוי את מתחתיו ובשדה להחליף, רוצים שאנחנו

בעברית.) במסמכים עובד לא

הידעת?

שלו. הכנפיים את מאבד מלאך - נייר על בית שיעורי מכינים שאתם פעם בכל

Symbolab באתר חכם מחשבון

ולא הראשון, הסמסטר בתחילת לא כבר ואתם מהר, להכפיל רוצים שאתם מטריצות שתי לכם ויש נניח

או מטריצה, ללכסן רוצים אתם שלחילופין או המטריצות, מכפלת מיומנות על לעבוד צריכים שאתם מרגישים

Copy-Paste לקבל שיודע חכם מחשבון לכם מציע Symbolab האתר בזריזות. דיפרנציאלית משוואה לפתור

להעתיק, כדי Ctrl+C תקישו אותם, תסמנו בליך, הביטויים את כתבתם כבר שאם אומרת זאת מליך. ישירות

רוצים אתם אם הבעיה. את לכם יפתור כבר והוא - שם המרכזי הטקסט בשדה Ctrl+V הקישו לאתר, לכו

פשוט וכדומה, פולינום של שורשים עצמיים וקטורים לכסון, כמו אריתמטיקה, מסתם יותר שהוא חישוב לבצע

לליך: חזרה להעתיק תוכלו התשובה את המתמטי. הביטוי לפני רוצים שאתם מה את תכתבו

וליך: ChatGPT של שילוב

היטב. אותו מבין ChatGPT ולכן באינטרנט מאוד נפוץ הוא (Tex) ליך של המתמטי הכתיב

כנראה והוא לצ’אט מהליך התוכן את תעתיקו פשוט - דאגה אל - טעיתם איפה מוצאים לא אתם לדוגמה, אם,

דוגמה: להלן בסיסית. היא אם במיוחד הטעות, את ימצא
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הטעות: את מוצא ישר הוא ChatGPT עם לצ’אט ומדביק מעתיק וכשאני

שימושיים סקריפטים

בסיכום המופיעים ההגדרות/טענות/... כל של אחת ברשימה ריכוז - למתמטיקאים

כל של רשימה ממנו ולחלץ הסיכום כל את לקחת שתרצו סביר מהכיתה, ההרצאות את מסכמים אתם אם

Theorems-ב שימוש לסעיף גשו Theorems המושג (על הארוכים וההסברים ההוכחות בלי השונים, Theorems-ה

.(

ככה: נראה וזה למבחן, ללמוד שמתחילים לפני או התרגיל את לפתור שניגשים לפני נוח מאוד זה
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כל עם שלו, העתק ומייצר ליך קובץ שלוקח פייתון סקריפט מראש הכינותי זה בשביל בדיוק אז

צבעים. עם בסוף יפה ככה מרוכזים ההגדרות/טענות/למות/משפטים

לאיבר Reference עם ברשימה האיבר את ייצור הסקריפט אז המקורית, לטענה Label הצמדתם אם מזה, יותר

על ללחוץ פשוט אפשר שלה, ההוכחה את לקרוא שרוצים טענה ומוצאים הנקודות על כשעוברים (ואז המקורי

המקורית). לטענה ישירות קופץ PDF-וה Reference-ה

מבחנים. תקופת בזמן נכתב הוא - הקוד נראות את תשפטו אל לסקריפט. לינק הזה בלינק זמין הסקריפט

יכול לא הסקריפט ( Theorems-ב ב-שימוש (כמתואר בליך המובנים Theorems-ב תשתמשו לא שאם לב שימו

בעצמו. הטענות את למצוא

kalikton.py - במסמך התמונות כל של הגודל של מחדש הגדרה

מגבולות לחרוג יכולה אפילו והיא מדי גדול יהיה PDF-ב תופיע היא שבו הגודל למסמך תמונה כשמכניסים לרוב

העמוד. לרוחב שתתאים ככה התמונה של הגודל את ידנית לשנות איך ראינו למסמך תמונות ב-הכנסת העמוד.

התמונות. כל של הגודל את לשנות מייגע קצת תהליך להיות יכול זה תמונות, הרבה עם גדול קובץ כשכותבים

אם הטקסט. של העמודה מרוחב 65% להיות כולן את ומשנה במסמך התמונות כל על עובר הבא הסקריפט

העתק גם יוצר הסקריפט הסקריפט. בתוך המספר את לשנות מוזמנים אתם 65 מהמספר מרוצים לא אתם

עורכים. שאתם הליך קובץ עם תיקייה באותה השינוי לפני המקורי המסמך של

SlickRun התוסף

טוב הכי הדבר כי פה זה את שם אני זאת בכל אבל לליך ספציפית קשור לא וזה SlickRun את כתבתי אני לא

שמופיעים הסקריפטים שני של בהקשר שימושי זה ובפרט ,Windows-ב המחשב על מהר לעבוד שרוצה למי

הקודמים. בסעיפים

שעל קובץ/תיקייה/סקריפט ולכל באינטרנט אתר לכל זריזים קיצורים להגדיר לכם מאפשר SlickRun בפשטות,

Windows של Run חלון כמו זה במקלדת. לחיצות בשלוש-ארבע מקום לכל לגשת יכולים שאתם ככה המחשב,

אוטומטית. השלמה לו ויש קיצורים, בו להגדיר למשתמש וידידותי קל שיותר רק

יתחרט. לא שהוא אותו שיתקין מי לכל מבטיח ואני טהור זהב הוא SlickRun-ה

התמונות כל את שמקטין (זה הקודם שמהסעיף kalikton.py הסקריפט את להריץ רוצה אני אם נגיד, אני

אחרי כבר .kalikton להקליד מתחיל ואז SlickRun את לפתוח כדי Ctrl+Shift+A לוחץ רק אני ליך), בקובץ

הקובץ את פותח הוא Enter לוחץ וכשאני מראש שהוגדר “kalikton” לקיצור אותי משלים הוא “ka” שהקלדתי

כך: נראה זה הרצוי.
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טריגונומטריות זהויות עמוד סימבולב, דסמוס, הם SlickRun-ב להגדיר סטודנט לכל ששווה קיצורים עוד

של לסקריפטים קיצורים קורס, כל של לתיקייה קיצור לפיזיקאים, הרמוניות ספריות של עמוד בויקיפדיה,

וליך. PyCharm כמו מרכזיות לתכנות וקיצורים הקודמים הסעיפים בשני שמופיעים הליך

את לראות אמורים ואתם התכנה את הריצו שהתקנתם, אחרי הזה. לעמוד גשו SlickRun את להתקין כדי

על תמיד יופיע לא שהחלון כדי הקודמת. שבפסקה האחרונה בתמונה כמו המסמך בתחתית קטנה טקסט תיבת

ככה: SetUp-ל ולכו ימני מקש עליו לחצו לו קוראים כשאתם רק אלא המסך,

מעדיפים): אתם אם אחרות אופציות (או הבאות האופציות את הגדירו ובו הבא החלון לכם ייפתח
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של הבאה בדוגמה כמו הקיצור את והגדירו Library-New Magic Word ללשונית לכו חדש קיצור להגדיר כדי

:desmos

ספציפיים סימנים של הגדרות

אותם. לתקן ונרצה כהלכה שלא מופיעים שהם או בליך, קיימים שלא מתמטיים סימנים ישנם לפעמים

- בקיצור (או Document -> Settings -> LaTex Preamble לגשת צריך מתמטי סימן לתקן/להוסיף כדי

ניגשים איך מזכיר אני הבאה בתמונה שם. שמופיעה הגדולה הטקסט לתיבת לאטך קוד ולהוסיף (alt d s

יוסיפו/יתקנו הם אותם תדביקו שאם ספציפיים, קוד קטעי אצרף הבאות ובפסקאות ,LaTex Preamble-ל

מסויימים: מתמטיים סימנים
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הבאה: בדוגמה כמו מוזר זנב עם מופיע Longrightarrow החץ אם .1

אותו: תתקן הבא הלאטך קוד של הוספה אז

% Correct odd arrow rendering:

\DeclareFontFamily{OT1}{cmrx}{}

\DeclareFontShape{OT1}{cmrx}{m}{n}{<->cmr10}{}

\let\saveLongrightarrow\Longrightarrow

\makeatletter

\renewcommand*{\Longrightarrow}{%

\mathrel{\rlap{\fontfamily{cmrx}\fontencoding{OT1}\selectfont=}%

\hphantom{\saveLongrightarrow}%
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\llap{$\m@th\Rightarrow$}}}

\makeatother

\let\saveLongleftarrow\Longleftarrow

\makeatletter

\renewcommand*{\Longleftarrow}{%

\mathrel{\rlap{$\m@th\Leftarrow$}%

\hphantom{\saveLongleftarrow}%

\llap{\fontfamily{cmrx}\fontencoding{OT1}\selectfont =}}}

\makeatother

את LaTex Preamble-ל הוסיפו אז (
⋃
· ו- ∪· ) זר לאיחוד המתמטי הסימן את להוסיף רוצים אתם אם .2

הבא: הקוד

% Define disjoint union:

\makeatletter

\def\moverlay{\mathpalette\mov@rlay}

\def\mov@rlay#1#2{\leavevmode\vtop{%

\baselineskip\z@skip \lineskiplimit-\maxdimen

\ialign{\hfil$\m@th#1##$\hfil\cr#2\crcr}}}

\newcommand{\charfusion}[3][\mathord]{

#1{\ifx#1\mathop\vphantom{#2}\fi

\mathpalette\mov@rlay{#2\cr#3}

}

\ifx#1\mathop\expandafter\displaylimits\fi}

\makeatother

\newcommand{\cupdot}{\charfusion[\mathbin]{\cup}{\cdot}}

\newcommand{\bigcupdot}{\charfusion[\mathop]{\bigcup}{\cdot}}

\bigcupdot-ו \cupdot הפקודה את להמיר שלכם המחשב של Texל תאפשר הזר האיחוד של שההוספה לב שימו

לזה. ייעודי סימן לנו יהיה בליך שגם רוצים אנחנו - מספיק לא זה אבל זר, איחוד של
⋃
· ו- ∪· לסימן

alt i h בקיצור: או ,insert -> math -> macro-ב בחרו חדש, מאקרו (להגדרת הבא המאקרו את נגדיר לכן,

ובשדה (LaTex Preamble-ב שהגדרנו החדש הסימון (שזה \bigcupdot או \cupdot נכניס Tex בשדה כאשר ,(o

.((\dot{\cup}) כך: מוגדר שהוא ,∪̇ הסימן זה נגיד, (אצלי, מכיר כבר שהליך כלשהו מתמטי סימן נכניס Lyx

אצלי: נראה זה ככה
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נתון אינדיקטור מה: משום ושוב שוב שואלים שאנשים שאלה זאת אבל חדש, סימן של הוספה לא זה .3

על בהקשה מוכנה זה שלי, macros-וב שלי בקיצורים שמשתמש למי .1 : \mathds{1} הקוד: ידי על

.alt+m 1

טקסט עמודות שתי עם מסמך יצירת

Document-Settings-Text-ב לסמן זה זריז הכי אקדמאי, מאמר כמו טקסט, שורות שתי עם יהי שהמסמך כדי

:Two-columns Document האופציה את Layout

העמודות. שתי על שמשתרע Abstract לעשות מאפשרת לא שהיא היא הזאת באופציה הבעיה

“Two-columns Document” האופציה את נסמן לא אז אחת, עמודה לבין עמודות שתי בין לזגזג נרצה אם

כך: נעשה ובמקומה האחרונה, מהתמונה

כמו ,\usepackage{multicol} הטקסט את איפשהו ונרשום Document-Settings-Latex Preamble-ל נלך .1

הבא: המסך בצילום
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עמודות. שתי רוצים אנחנו ממנה שהחל בנקודה הסמן את נשים .2

ובסוף .\begin{multicol}{2} הטקסט: את בה ונרשום Tex Code סביבת ליצור כדי Ctrl+L נלחץ .3

הבא: המסך בצילום כמו \end{multicol} הטקסט את נכניס ובה זהה סביבה נפתח המסמך

אחרי עוקבים אז “package multicol.sty not found” מהצורה: שגיאה מקבלים כשמייצאים אם .4

.17 שבעמוד חדשות“ חבילות ”התקנת הכותרת שתחת חבילה להתקנת ההוראות

הזה. בלינק זמין לדוגמה קובץ .5

הקיצורים קובץ של וייצוא ייבוא גיבוי,

אותה. להרשים כדי יפה לבחורה אותו לשלוח או שלכם, הקיצורים קובץ את לגבות רוצים ואתם נניח

כדי שמור. הוא בה ומהתיקייה אל להעתיק ניתן אותו אחד, טקסט בקובץ שמורים בליך שלכם הקיצורים כל

הקיים. הקובץ את ולדרוס בתיקייה הוקבץ את להדביק צריך פשוט אחר מישהו של קיצורים לייבא

מקוצר. ניתוב ולא האבסולוטי, הניתוב את לשים יש - חשוב

זה: הוא Windows-ב לתיקייה המלא הניתוב

C:\Users\<YOUR_USER_NAME>\AppData\Roaming\LyX2.<3 or 4>\bind

:MAC-ב או

Users/<YOUR_USER_NAME>/Library/Application/Support/LyX-2.<3 or 4>/bind
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יכול לא אני ולכן לאחר, אחד ממחשב שמשתנים בניתוב חלקים ישנם האדום, בפונט רואים שאתם כמו

והקלידו WindowsKey+R הקישו ידנית, אליו להגיע כדי שלכם. במחשב המדוייק הניתוב את פה לכם לרשום

עליו) מיקרוסופט של האייקון עם Alt-ה לבין Ctrl-ה שבין המקש זה WindowsKey) %AppData%

:user רק או user.bind השם תחת נתון יהיה והקובץ שבתמונה הבא לניתוב גשו

Ctrl+s-ו משוואה לפתיחת Ctrl+m (כמו עובדים לא הליך עם שמגיעים הבסיסיים הקיצורים פתאום במקרה אם

בתמונה: כמו הבא הקובץ את ובחרו tools-preferences-ל לכו דאגה, אל לשמירה)
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המדליך של הקיצורים קובץ

את הורדתם אם עקרונית .2.3 לליך וגרסא 2.4 לליך גרסא - גרסאות שתי ישנן המדליך של הקיצורים לקובץ

בכל אתם אם .2.3 אז כן לפני הורדתם ואם 2.4 להיות אמורה שלכם הגרסא 2024 מאי אחרי מהאתר Lyx

הקודם, בסעיף שמופיע הקיצורים קובץ של בניתוב אז שלכם במחשב שמותקנת הגרסא מהי לוודא רוצים זאת

שלכם. הליך של הגרסא הוא הקיצורים קובץ של התיקייה את שמכילה התיקייה שֵם

על עובדים אתם אם או, פה, למצוא ניתן אותם שלי, macros-ב שמשתמשים קיצורים מספר שישנם לב שימו

אותם הורידו בהם להשתמש כדי חובה. לא אם גם בהם, להשתמש רצוי מפה. אותו הורידו אז באנגלית מסמך

שלכם. הקבצים כלל בתוך אחד macros קובץ כלילת שבסעיף ההוראות אחרי ועקבו נגיש למקום

(לליך הזה בלינק זמינים הקיצורים !Mac-ל מותאם בקובץ קיצורים אותם - מויצמן נווה באדיבות ועכשיו!

Ctrl-וה ,option-ל הועבר טקסט לעריכת בקיצורים Ctrl-ה ,Ctrl-ל עבר Alt-ש ככה שונו הקיצורים .(2.3

option+d-ל עברו alt+d-ב שמתחילים הקיצורים ספציפית כן, כמו .Command Key-ל הועבר אחרים בקיצורים

בעיות. למנוע כדי

הערות: מספר

ליך. את מחדש ותפתחו סגרו הקיצורים קובץ את שתייבאו אחרי •

הוכנסו) שלי שהקיצורים אומרת, (זאת .α הסימן את מכניס alt+w a-ש בדקו נעשה, שהשינוי לוודא כדי •

עובדים). לא קיצורים אחרת כי אנגלית על שאתם לב (שימו

עובדים לא הליך עם שמגיעים הבסיסיים הקיצורים פתאום במקרה אם הקודם, בסעיף שכתבתי כמו •

הקובץ את ובחרו tools-preferences-ל לכו דאגה, אל לשמירה) Ctrl+s-ו משוואה לפתיחת Ctrl+m (כמו
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בתמונה: כמו הבא

הקובץ: איכות על להעיד העברית האוניברסיטה של הליך לקבוצת אתן ולכן עיסתו על מעיד הנחתום אין •

מהמדליך: העיקריים הקיצורים פירוט להלן

שני בין + בקיצור רושם כשאני המסמך: באמצע הקיצורים על בסעיף גם שצויינה הערה על אחזור ראשית

השני. אחרי אחד בנפרד נלחצים הם אז מקשים שני בין רווח וכשיש ביחד, נלחצים שהם היא הכוונה מקשים
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שניהם את עוזבים ואז ביחד i-ו ctrl לוחצים קודם שבו הקיצור את מסמל “ctrl+i b” הביטוי אומרת, זאת

.b המקש על ולוחצים

הקונבנציה זאת ביחד. q-ו shift-ו ctrl המקשים שלושת של לחיצה הוא זאת, לעומת “ctrl+shift+q” הביטוי

הזה. למסמך מחוץ גם הכללית

תכופים שקיצורים אומרת זאת מהירה. שיותר כמה תהיה איתם שהכתיבה ככה נבחרו הקיצורים .6 הערה

alt+w-ב מתחילות היווניות האותיות כל בפרט, אליהם. להגיע שקל מקשים על מקלדת לחיצות מעט דורשים

שמאל יד עם להקליד שאפשר זריזים, הכי הקיצורים הם alt+q-ו alt+w-ש משום - alt+q-ה הפונקציות וכל

גם שהקיצור צריך בזריזות, להתחשב די שלא טוענים אנשים שומע אני לעיתים היד. את למתוח מבלי בלבד

20 בערך לכם ייקחו אומר: אני כך על יווניות. לאותיות איכשהו קשור alt+w-ש לזכור וקשה זכיר, יהיה

.alt+q-ו הפונקציות עם הדבר ואותו ,alt+w-ב מתחילות יווניות שאותיות לזכור כדי יווניות אותיות של הקלדות

שלאף מבטיח ואני הראשון, הסמסטר של הראשון בשבוע מהר נבנה והוא משלהם, זיכרון באצבעות לשרירים

קלי. של מילה - התכופים הקיצורים את לזכור בעיה תהיה לא אחד

”חשוב!“ בסימון: מסומנים מאוד שימושיים קיצורים

.Shift+_-ב תחתון וכתיב Shift+6-ב בחזקה העלאה .1

α הענייין לצורך ליך). של המחדל בברירת כמו alt+m g-ב (ולא alt+w-ב מתחילות יווניות אותיות .2

.alt+w w ידי על מוכנסת ω-ו alt+w a ידי על מוכנסת

הלאה.) וכן alt+q e-ב זה exp ,alt+q c זה cos (נגיד alt+q-ב מתחילות פונקציות .3

מחוץ הסוגריים את פותחים שאיתם המקשים עם יחד ctrl-ב מכניסים הסוגריים סוגי כל את חשוב! .4

,ctrl+[ ידי על מוכנסים מרובעים סוגריים ,ctrl+shift+( ידי על מוכנסים רגילים סוגריים לדוגמה לליך.

וכדומה. ctrl+shift+{ ידי על מוכנסים מסולסלים סוגריים

הבאים המיוחדים הסוגריים ישנם בנוסף

alt+i shift+(-ב (] (א)

alt+i ב-] [) (ב)

alt+q ב-> או alt+Shift+<-ב ⟨| (ג)

alt+q ב-< או alt+Shift+>-ב |⟩ (ד)

(alt+p 2 , alt+p 3...) ספרה ואז alt+p-ב מתחילים לכותרות קיצורים .5

alt+e ידי על מוכנסת claim פסקת לדוגמה, .alt+e-ב מתחילים (Theorems) פסקאות לסוגי קיצורים .6

.alt+e t ידי על מוכנסת theorem ופסקת c

:alt+i-ב מתחילים הקבוצות תורת של סימונים .7

(in (מלשון alt+i i-ב ∈ (א)

78



.(subset (מלשון alt+i b-ב ⊆ (ב)

.(supset (מלשון alt+i b-ב ⊇ (ג)

איכשהו) חזק יותר אבל subset כמו הוא (כי alt+i shift+b-ב ⊂ (ד)

איכשהו) חזק יותר אבל supset כמו הוא (כי alt+i shift+p-ב ⊃ (ה)

הלאה וכן alt+i c-ב C ,alt+i r-ב R ,alt+i f-ב F (ו)

צבעים: .8

זה באדום וצביעה alt+o b זה בכחול צביעה (נגיד, alt+o-ב מתחילה טקסט/מתמטיקה של צביעה (א)

(.alt+o r

.alt+o k-ב תחתון) ופס בולד (כולל העיצובים כל של הסרה

(לצערי .(alt+o shift+g-ב תהיה בירוק והדגשה צביעה (נגיד alt+o shift+<letter> והדגשה: צביעה (ב)

(Lyx ב-2.3 רק המתטיקה סביבת בתוך עובדים האלו הקיצורים

- האחרון) המתמטי הביטוי (או הסמן לפני האחרונה המילה של בדיעבד והדגשה צביעה/צביעה (ג)

הסמן הנחת ידי על בחום האחרון הביטוי של צביעה (נגיד, alt+d מקישים קודם אבל הדבר אותו

.(alt+d alt+o n של לחיצה ואז אחריו

ההוראות אחרי עקבו וכו’) הגדרה משפט, הטענה, (סביבות השונים Theorems-ה של לצביעה הערה:

49 שבעמוד שרם“ גלעד באדיבות - משודרגים Theorems-ב ”שימוש הכותרת שתחת

מאשר לעיניים נוח יותר קצת שזה שחור, נשאר והתוכן צבועים, עצמם (הסוגריים צבועים סוגריים (ד)

הלאה: וכן alt+o alt+r או alt+o alt+b-ב הטקסט) כל את לצבוע

iψ̄γ5ψ
T−→ Tiψ̄γ5ψT \ Add redundant Ts

= −iT ψ̄T��Tγ5��TTψT \Simplify

= −
(
T ψ̄T

)
γ5(TψT ) \Take expression from exercise

= −
(
ψ̄ (−x̃) γ1γ3

)
γ5
(
γ1γ3ψ (−x̃)

)
\Symbolab

=
(
ψ̄ (−x̃)

)
γ5(ψ (−x̃))

הליך: עם שמגיעה שלהם מהגרסא יותר קצרים העיטורים רוב קיצורי .9

alt+f-ב (שבר) a
b
(א)

alt+.-ב ȧ (ב)
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alt+z-ב ä (ג)

alt+x-ב a (ד)

alt+m m-ב ã (ה)

alt+c a-ב ��asd (ו)

alt+e b-ב asd (ז)

מיוחדים:

למעלה החץ על ולוחצים מתמטיקה לסביבת מימין עומד כשהסמן שבה מעצבנת בתופעה נתקלים לפעמים .10

ctrl אומרת, (זאת הבעיה את פותר ctrl+UpArrow מגיב. לא זה שמעל) לשורה הסמן עם לעלות (כדי

למעלה) החץ ואיתו

משוואות: מערכת של ויצירה משוואות של להעתקה שנוגעים קיצורים .11

ctrl+’-ב למטה שלה הֵעֵתק של והדבקה משוואה של העתקה חשוב! הכי (א)

נוספים סוגים ישנם ככה עצמה, משל בשורה או המשפט, בתוך לשבת יכולה שמשוואה שראינו כמו (ב)

במערך שיושבות משוואות מספר ישנם בו - משוואות“ ”מערכת הוא הסוגים אחד משוואות. של

לשניה. מתחת אחת מיושרות כשהן PDF-ב יופיעו והן אחד,

משוואות: למערכות קיצורים

ctrl+enter יושב: הסמן שבה למשוואה מתחת המשוואות במערכת משוואה עוד של פתיחה i.

בעצמו) משוואות למערכת אותה יהפוך זה רגילה, הייתה המשוואה אם גם (עובד

ctrl+alt+enter יושב: הסמן שבה למשוואה מימין המשוואות במערכת משוואה עוד של פתיחה ii.

יושב שבה המשוואה את להמיר כדי :Lyx ב-2.3 רק עובד ולצערי מאוד נוח הבא הקיצור iii.

נוח זה .ctrl+alt+’ החדשה: לשורה ימין אגף את להעתיק וגם משוואות למערכת הסמן

הבאה: מהצורה מעבר לעשות כשרוצים

[AB,C] = ABC − CAB

= ABC − ACB + ACB − CAB

= A (BC − CB) + (AC − CA)B

= A [B,C] + [A,C]B

המשוואה כל את להעתיק וגם משוואות למערכת הסמן יושב שבה המשוואה את להמיר כדי iv.

.ctrl+alt+; החדשה: לשורה
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(לרדת באמצע אותה לשבור ורוצים מאוד ארוכה שיוצאת משוואה כותבים לעיתים מגניב! v.

סוגריים ישנם אם נוח שורות, לכמה שמפוצלת אחת משוואה שזו ברור שיהיה כדי שורה).

הקיצור האחרונה. השורה בסוף ונסגרים הראשונה השורה בתחילת שנפתחים אדומים

להיפתח, צריכים הסוגריים שבו במקום יושב כשהסמן אותו מפעילים אם ,ctrl+shift+enter

זה. את בדיוק עושה

הבאה: במשוואה הכחול ה-+ אחרי יושב הסמן אם לדוגמה,

במקום, יושב כבר (והסמן הזה למצב המשוואה את תביא ctrl+shift+enter על לחיצה אז

לכם): רק מחכה ככה

ימני הכי המשוואה,בצד בסוף יושב (כשהסמן alt+\ \ עם עושים שאתם האלגבריות הפעולות של תיעוד .10

כשמתרגלים: בזריזות נעשה וגם ברורים למאוד הפיתוחים את הופך זה שלה).

6x2 + 10x+ 24 = 4x2 − 4x \ − 4x2 + 4x

2x2 + 14x+ 24 = 0 \ · 1
2

x2 + 7x+ 12 = 0 \Solve

x ∈ {−3,−4}

בצד משוואה, בתוך יושב כשהסמן (גם, alt+\ n ואת alt+\ e את alt+\ i את נסו הזה, בהקשר כן, כמו

שלה) ימני הכי

.ctrl+shift+q-ב אז מעליו ההערה ואם ctrl+q-ב היא סומן) שהוא (אחרי לביטוי מתחת הערה של הכנסה .11

לדוגמה:

P (A) =
365

365
· 364
365

· . . . · 365− (n− 1)

365
=

365!

(365− n)!︸ ︷︷ ︸
|A|

· 1

365n︸ ︷︷ ︸
1/|Ω|

=
|A|
|Ω|
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שאפשר מתאים קיצור יש וכדומה) בוקטור כמו עליון קו סוגריים, (שורש, שהיא סביבה לכל חשוב! .12

המתאים. המקש ואז alt+d עם מימינו) יושב והסמן הביטוי את שכתבתם (אחרי בדיעבד אותו להחיל

המספר על בסוף ורק ”חלקי“ על זה אחרי פאי, על חושב קודם אני שלי בראש ,π
2
הביטוי בכתיבת נגיד,

הסימן את להכניס קודם אפשר שלי, בראש שהם כמו סדר באותו במקלדת הסימנים את להכניס כדי .2

של ההכנסה של הסדר ככה, .2 ואז לשבר) המתאים המקש זה כי f) alt+d f להקיש כן אחרי ,π

דומה באופן הכתיבה. על לשטף עוזר וזה חושבים כשאנחנו שלנו בראש שלהם הסדר כמו הוא הסימנים

על סוגריים להחיל כדי alt+d ( הקיצור את בדיעבד, ˙ הסביבה את להחיל בשביל alt+d . הקיצור ישנו

וכדומה. הסמן שמאחורי הביטוי

בפרט:

alt+d h-ב הסמן שלפני לביטוי בדיעבד ˆ כובע להוסיף (ג)

alt+d f-ב שבר של למונה הסמן שלפני הביטוי את להכניס (ד)

alt+d ב-. הסמן שלפני לביטוי ˙ נקודה להוסיף (ה)

alt+d m-ב הסמן שלפני לביטוי ˜ להוסיף (ו)

alt+d s-ב הסמן שלפני לביטוי √ ריבועי שורש להוסיף (ז)

alt+d r-ב הסמן שלפני לביטוי ריבוע בהכרח שאינו שורש להוסיף (ח)

alt+d ב-2 a† דאגר להוסיף (ט)

alt+d ב-8 a∗ בחזקה כוכבית להוסיף (י)

alt+d shift+T-ב AT Transpose להוסיף (יא)

להקיש עדיף כובע/נקודה/טילדה להוסיף כדי אז חזקה, או אינדקס יש הסמן שלפני לביטוי אם (יב)

הסביבה ואז - השניה) האות עם גם לחוץ alt-ה את להשאיר אומרת, (זאת alt+d alt+h/./m

לא החזקה או והאינדקס החזקה, או האינדקס שלפני לאות רק תתווסף הכובע/נקודה/טילדה של

לסביבה. כן גם ייכנסו

alt+d ותלחצו a = b כתבתם ואם ,U ∋ x-ל תהפוך המשוואה alt+d i ותלחצו x ∈ U כתבתם אם (יג)

.b = a-ל תהפוך היא =

עם קטנה סביבה תופיע אז alt+d alt+= ותלחצו אחריו, יושב והסמן שוויון סימן כתבתם אם (יד)

לדוגמה: השוויון. מגיע מאיפה לרשום תוכלו בה לשווה, מעל בתוכה הסמן

a
symmetry From

= b

נוספים: שטיקים
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ctrl+p-ב בריבוע העלאה חשוב! .13

ctrl+;-ב a−1 כזה: הופכי .14

alt+’-ב f ′ כזה: צ’וקו עם גזירה .15

alt+q alt+d-ב ∂
∂x

חלקית וגזירה alt+q d-ב d
dx

מלאה גזירה .16

(דורש alt+1 הקשת ידי על מתאפשר זה ,✓ בסוף להוסיף נחמד מתקיים שמשהו לוודא שרוצים פעם בכל .17

שלי). macros-ה קובץ את

שורה. וירידות הזרחות על שומרת לא לליך מחוץ שהעתקתם טקסט של ctrl+v עם רגילה הדבקה .18

לשמור כדי .(insert-program listing (תחת program-listing בסביבת כשמדביקים בעיקר בזה נתקלים

ctrl+shift+v-ו שלי הקיצורים בקובץ שמשתמש למי ctrl+alt+v עם הדביקו והזחות שורה ירידות על

אתם אם ,clipboard-paste נקראת הקיצור של עצמה (הפקודה שלי. הקיצורים בקובץ משתמש שלא למי

אחר) לקיצור אותה להזיז מעוניינים

למשוואות, במסמך, אחרים לחלקים ולינקים “התייחסויות בסעיף שמפורט (כמו למשוואה label לתת כדי .19

שהקיצור לב שימו .alt+r r לחצו למשוואה reference להכניס וכדי alt+r l לחצו (52 בעמוד וכו’“ לטענות

לטקסט לחזור כדי איתו, שסיימתם אחרי ולכן לכחול, הרפרנס של הפונט צבע את ממיר גם האחרון

.alt+o k לחצו שחור,

.alt+3-ב-וב זמינה יחידות לבדיקת סביבה התרגיל, את כשמסיימים יחידות לבדוק רצוי לפיזיקאים, .20

ליחידות) המתאים הפונט (שנחשב m/s2 הזה: לפונט m/s2 הזה: הפונט את ממירה הסביבה

לאינפי: שימושיים קיצורים .21

alt+q l-ב lim (א)

alt+q shift+l-ב limn→∞ (ב)

.alt+/-ב → (ג)

alt+q ב-/ kaki−−→
pipi

(ד)

alt+q shift+/-ב −−−→
n→∞

(ה)

ctrl+shift+u-ב
∑∞

n=1 (ו)

שמשמאל האות על בדיעבד זה את לעשות וכד alt+‘ a-ב השתמשו (an)
∞
n=1-ב an את להקיף כדי (ז)

.alt+d a אז ידנית אותו לסמן מבלי לסמן

alt+q alt+d-ב ∂
∂
חלקית ונגזרת alt+q d-ב d

d
נגזרת (ח)
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של ההערכה את לסמן נהוג .(x = x0-ב (נגיד, מסויימת בנקודה נגזרת להעריך רוצים פעמים הרבה (ט)

כך: מסויימת בנקודה הנגזרת

df

dx

∣∣∣∣
x=x0

הביטוי את ייקח זה alt+d alt+] לחצו ואז (df
dt
הביטוי את (נגיד, הנגזרת את תכניסו זה בשביל

למטה יושב שהסמן ככה מימין, הזה האנכי הקו עם בסביבה אותו וישים שרשמתם הנגזרת של

:x = x0 רושמים שבו במקום

וקבוצות: כמתים .22

alt+i k-ב ∀ (א)

alt+i h-ב ∃ (ב)

alt+i i-ב ∈ (ג)

alt+i shift+i-ב ∋ (ד)

(suberset מלשון b) alt+i b-ב ⊂ (ה)

(superset מלשון p) alt+i p-ב ⊃ (ו)

שלי) המאקרוז קובץ את (דורש alt+i r-ב R (ז)

שלי) המאקרוז קובץ את (דורש alt+i c-ב C (ח)

שלי) המאקרוז קובץ את (דורש alt+i q-ב Q (ט)

שלי) המאקרוז קובץ את (דורש alt+i z-ב Z (י)

alt+i ב-] [) (יא)

alt+i Shift+(-ב (] (יב)

לינארית: לאלגברה שימושיים קיצורים .23

.alt+shift+v-ב מרובעים סוגריים עם ווקטור alt+v-ב מעוגליים סוגריים עם וקטור (א)

מורחבת ומטריצה ,alt+m d עם לדטרמיננטה מטריצה ,alt+m a ידי על מתקבלת

(
1 2

3 4

)
מטריצה (ב)

.alt+m e עם משוואות למערכת
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הקישו אז בעיקר) קוונטי למחשוב (חשוב והעמודות לשורות כותרות יש שבה מטריצה תרצו אם (ג)

:alt+m shift+a

|00⟩ |01⟩ |10⟩ |11⟩
⟨00|
⟨01|
⟨10|
⟨11|

נמצאות בתוכה) ולא המטריצה, אחרי ממש יהיה שהסמן (דורש מטריצה על אלמנטריות פעולות (ד)

לדוגמה: .alt+e 1,alt+e 2,alt+e ב-3

(
1 2

1 3

) {
R2 → R2 −R1

⇒

(
1 2

0 1

)

בעצמכם) לשנות תצטרכו הערכים את בעצמו, חישובים לעשות יודע לא שליך לב (שימו

לבסיסים: נפוצים סימונים (ה)

alt+w shift+A-ב A i.

alt+w shift+B-ב B ii.

alt+w shift+C-ב C iii.

משוואות: של ומערכות טבלאות מטריצות, של עריכה חשוב! (ו)

alt+]-ב שורה הוספת i.

alt+[-ב שורה מחיקת ii.

ctrl+alt+]-ב עמודה הוספת iii.

ctrl+alt+[-ב עמודה מחיקת iv.

לקוונטים: שימושיים קיצורים .24

alt+w alt+h-ב h̄ (א)

והטלות: ברה קט, (ב)

alt+q ב-> או alt+Shift+<-ב ⟨| i.
alt+q ב-< או alt+Shift+>-ב |⟩ ii.

ctrl+<-ב ⟨⟩ iii.

ctrl+\-ב | iv.

ctrl+shift+H-ב H המילטוניאן (ג)
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שלי) macros-ה את (דורש alt+m ב-1 1 היחידה אופרטור (ד)

.Shift+F Shift+M Shift+L ב- FML (ה)

.alt+d ב-8 האחרון הביטוי של בחזקה ∗ להוסיף (ו)

.alt+d ב-2 האחרון הביטוי של בחזקה דאגגר להוסיף (ז)

.alt+d h-ב כובע עם לאופרטור האחרון הביטוי את להפוך (ח)

קובץ את הורדתם אם רק האלו בקיצורים להשתמש (אפשר שבניתי מיוחדים macros-ל קיצורים .25

הסעיף): בתחילת שהגדרתי כמו macros-ה

השתמשו v1+ v2+ . . .+ vk או U1⊕U2⊕ . . .⊕Um או a1 · a2 · . . . · an התבנית את להכניס כדי (א)

.alt+‘ s בקיצור

.alt+‘ d s-ב השתמשו a1 · v1 + a2 · v2 + . . . an · vn התבנית את להכניס כדי (ב)

מהמדליך הקישורים כל ריכוז

תוכנות: .1

המדליך של עדכנית הכי הגרסא (א)

פייתון) (דורש ארזים של TexLive-ו לליך האוטומטית ההתקנה סקריפט (ב)

ליך של המקוריות ההתקנה הוראות (ג)

שריה) (באדיבות MacOs-ל התקנה הוראות (ד)

Tex Live הורדת (ה)

ליך הורדת (ו)

TexLive-ב עדכניות שגיאת תיקון קובץ (ז)

TexLive התקנת הוראות (ח)

:macros-ו קיצורים .2

המדליך של הקיצורים קובץ (א)

הישנה) 2.3 (לגרסא המדליך של הקיצורים קובץ (ב)

(MAC-ל) המדליך של הקיצורים קובץ (ג)

המדליך של macros-ה קובץ (ד)

באנגלית) (למסמכים המדליך של macros-ה קובץ (ה)

לדוגמה: ליך קבצי .3
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Standard, minimal - ראשונה וריאציה (א)

Hebrew Article - שניה וריאציה (ב)

Standard, fancy - שלישית וריאציה (ג)

המסמך בשאר עמודות ושתי בהתחלה אחת עמודה עם וריאציה (ד)

באנגלית וריאציה (ה)

שימושיים: ואתרים חיצוניים תוספים .4

הטענות לריכוז סקריפט - קלילמוד (א)

במסמך התמונות כל של מחדש להגדלה סקריפט - קליקטון (ב)

ליך במשתמשי לתמיכה ווטסאפ קבוצת - ” ושטיקים טריקים - ”ליך (ג)

שרם גלעד של מפונפנים Theorems (ד)

למחשב נפלא תוסף - SlickRun (ה)

קוד לסביבת תבניות (ו)

שכניה (ז)
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